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PREFACE 1

he MobileTrak™ User Guide v4.6 will help you understand 
Sunflower MobileTrak 4.6 including a section on the newest 
features available in MobileTrak. This guide provides insight, 

overviews, and instructions for this latest release of MobileTrak, 
whether you’re a current user who has experience with previous 
versions, or a prospective user interested in the new features and 
functionality that have been incorporated into this version of 
MobileTrak. 

This guide includes information on the following topics:

• Chapter 1 Sunflower Assets Application Setup

• CHapter 2 MobileTrak 4.6 Setup

• Chapter 3 Manage Asset Reads

• Chapter 4 Transfer (Upload) Physical Inventory

• Chapter 5 Get Help

• Appendix A Frequently Asked Questions

• Appendix B Common SyncLink Error Messages

• Appendix C Reports

T
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P R E F A C E
What’s New?
W H A T ’ S  N E W ?

Sunflower MobileTrak improves and simplifies the physical inventory process whether enterprise assets 
are located in a single building, across town, or across the world. The introduction of Sunflower 
MobileTrak v4.6, streamlines the physical inventory process with the addition of several new application 
features and enhanced mobile computing capabilities. This guide contains discussion and reference on 
the following new features and enhancements: 

• 2D Data Matrices: In addition to supporting traditional scanning methods for 1D barcodes, MobileTrak is 
also equipped to support the scanning of 2D data matrices (Marks).

• Radio Frequency Identification (RFID) scanning: In conjunction with Sunflower Assets, MobileTrak v4.6 
can accommodate multiple simultaneous reads of assets with RFID tags, thereby making it possible to 
scan more than one asset in a given location with just one push of the scanner button.

• Asset Marks: With new asset tracking technologies such as 2D data matrix and RFID being integrated into 
existing asset management processes, it is a requirement in some cases to replace traditional barcodes 
with new technology. If an asset is affixed with a new mark type and then scanned, MobileTrak will 
recognize the new mark type and prompt the barcode operator with a decision; Add the Mark to an existing 
asset or replace the mark.

• Unique Identification (UID) Entry: MobileTrak v4.6 supports the entry of Sunflower Assets UIDs, as well as 
Department of Defense UIDs.

• User Interface: MobileTrak’s graphic user interface has been given a new look and feel to improve the ease 
of navigation through the use of icons and more intuitive terminology on the main menu. Although the 
functionality of the menu items remains the same, the traditional list of menu items has been replaced with 
icons and accompanying terminology. For example, “File Statuses” is now “Review Scans.”

• Expanded Data Model: The data model has been expanded to include Organizations, People, Mark Types, 
Symbologies, and various other tables. Additional validation for fields such as custodian and steward has 
also been included. 

• Term Set Enabled: The Term Set (Personalized Application View) feature allows you to change the field 
names visible not only in your Sunflower Enterprise repository but also on the Barcode Scanner.

• User Defined Fields Extension: User Defined Fields (UDFs) have been extended to the MobileTrak 
application. Based upon your business policy, extend the appropriate UDFs to capture your organization’s 
unique data. Create up to 30 UDFs; these UDFs will display on the barcode scanner Asset Details page 
when you scan or manually enter an asset.

• Barcode Menu: Upon installation and configuration of MobileTrak 4.6 a new menu will be visible within your 
instance of Sunflower Assets call “Barcode”. This menu provides forms and reports specific to the 
management of Sunflower Mobile Applications. Based on the application you install (i.e. Sunflower 
MobileTrak), relevant forms and reports will be available for your use.

• Asset Reads and Asset Receiving: The MobileTrak menu now contains two ways in which to create an 
asset read, 1) Asset Reads screen, enhanced but similar to the former Asset Receiving screen, enables 
you to create resolutions for your physical inventories. 2) The Asset Receiving screen, which while similar 
to Asset Reads, is provided for the purpose of receiving new assets into your inventory.
ii Sunflower MobileTrakTM User Guide 4.6 Sunflower Systems © 2008 April
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. .P R E F A C E
What’s New?
• Error Management: New forms are available in the Sunflower Enterprise under a new menu called 
Barcode. Error forms help you manage and resolve issues that may arise when you process and transfer 
asset reads from the barcode scanner to the Sunflower repository via SyncLink.

• Report Management: New reports are available in the Sunflower Enterprise under the menu called 
Barcode. The reports, Difference Detail by Asset and Error Detail by Error Code enable you to better 
assess and resolve issues for the assets that are uploaded from the barcode scanner to the Sunflower 
repository.

• Mass Transfer: The mass transfer and print options are no longer available in MobileTrak v4.6. Mass 
transfers can be performed in Sunflower Assets.
Sunflower Systems © 2008 April Sunflower MobileTrakTM User Guide 4.6 iii



P R E F A C E
About this Guide
A B O U T  T H I S  G U I D E

The MobileTrak User Guide v4.6 is an introduction to the features and functionality that are compatible 
with the release of Sunflower Enterprise® v4.5. This guide is not intended to serve as a comprehensive 
guide for the entire Sunflower product offering. The information provided in this guide addresses new 
features, functions, and enhancements that have been added to MobileTrak since v4.0.

This document was prepared and tested using an Intermec handheld scanner. MobileTrak functionality 
will display the same on either the Intermec or Psion Workabout Pro scanners. However, there may be 
differences in barcode System Utilities tab (which are not MobileTrak functions) options that address 
the Battery Status and Alarm capabilities of the scanner.

I N T E N D E D  A U D I E N C E

This guide is designed for functional users who want to learn how to configure and use MobileTrak v4.6 
in conjunction with the Sunflower Enterprise v4.5 barcode scanner software suite.

A D M I N I S T R A T O R S  A N D  R E V I E W  M A N A G E R S

This guide provides administrators and review managers who are responsible for setting up and 
managing physical inventory efforts in Sunflower Enterprise with illustrations and discussions that 
address new features of Sunflower MobileTrak v4.6. This guide assumes that you have knowledge of 
your operating system and the relational database that supports your environment, as well as 
knowledge of the Review module in Sunflower Assets. 

F U N C T I O N A L  U S E R S

This guide provides functional users who are responsible for executing physical inventory efforts the 
knowledge to use the MobileTrak application to collect asset data using a handheld barcode scanner.
iv Sunflower MobileTrakTM User Guide 4.6 Sunflower Systems © 2008 April
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About this Guide
D O C U M E N T  C O N V E N T I O N S

This guide uses the following formatting conventions:

N A V I G A T I O N

Menu selections are displayed as a series of steps with bullets that define the name of the menu, 
submenu, icon, and/or screen.

Example: Access the MobileTrak Setup screen from the mobile device main menu as shown below: 

Figure 0-1: MobileTrak Main Menu

Step 1   Tap Start on the barcode scanner touch screen.

Style Meaning
Bold Field Term, Menu Name or Screen Name.

Field Value Input Value or List Of Values.

Emphasis Emphasized subject.

NOTE: Provides additional facts and tips.

. . . . . . . . . . . . . .
NAVIGATION

• Tap the Start 
icon 

• Tap MobileTrak 

• Tap the Setup 
icon
Sunflower Systems © 2008 April Sunflower MobileTrakTM User Guide 4.6 v



P R E F A C E
About this Guide
Step 2   If available, Tap the MobileTrak icon on the Start menu drop-down.

NOTE:  Alternatively, Tap Start > Programs > MobileTrak.

Step 3   Tap the Setup icon.

P E R F O R M  A N  A C T I O N

When performing a task, the guide will specify when and where you are required to take action by 
displaying the steps to execute next to the screen graphic, as shown above under Navigation.

A D D I T I O N A L  D O C U M E N T A T I O N

Visit the Customer Care section of the Sunflower Systems website at 
http://www.sunflowersystems.com to download the latest user guides for Sunflower Assets, 
MobileTrak™, ExcessTrak™, PackTrak™, Sentry™ and many other Sunflower product-related 
services and news.

For MobileTrak 4.6 installation information refer to the Readme.htm and Handheld.htm located 
in the “Doc” directory of the MobileTrak 4.6 installation zip file.

Access to downloads are available with a Sunflower Passport. Register for a Sunflower 
Passport on the http://www.sunflowersystems.com website.

C O N T A C T  U S

Your comments and feedback are welcome. Contact Sunflower Systems by one of the 
following: 

Annams Systems Corporation
Sunflower Systems
2420 Camino Ramon, Suite 130
San Ramon, CA 94583

Voice: (866) 209-3516 x201

Fax: (925) 355-0733

E-mail: helpdesk@sunflowersystems.com or training@sunflowersystems.com.
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SUNFLOWER SETUP 1

key component of a successful asset management strategy 
is the physical inventory process. Sunflower Enterprise® 
facilitates total asset visibility, asset security, and 

reconciliation of asset records during the physical inventory process 
by integrating seamlessly with MobileTrak™ to capture asset data with 
a single click of the scanner button. To make the most of these 
capabilities it is necessary to define the parameters of the physical 
inventory you wish to perform.

This chapter will discuss core concepts related to a physical inventory 
and define the process used to prepare for an inventory using the 
MobileTrak application. With a basic understanding of physical 
inventory fundamentals you can begin working with MobileTrak to 
scan assets.

This chapter will include the following discussion points and concepts:

• Lifecycle Asset Management

• About Physical inventory

• Sunflower Assets Setup

A
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S U N F L O W E R  S E T U P
Lifecycle Asset Management1  
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . L I F E C Y C L E  A S S E T  M A N A G E M E N T

Lifecycle Asset Management is the process of monitoring, managing, and accounting for 
assets throughout their lifecycle; from the time funds are obligated for an asset and 
procurement, through transfers of custodial and organizational accountability, physical 
inventory reviews, financial accounting including depreciation, capture of maintenance events, 
calculation of the cost of ownership, excess determination, and finally, retirement.

Figure 1-1: Sunflower Assets

Sunflower Assets delivers a robust enterprise application with the capability to manage all 
aspects of the asset lifecycle, including the audit process. As part of any sound asset 
management strategy, the auditing (or physical inventory) process facilitates total asset 
visibility, asset security, and reconciliation of asset records. In conjunction with MobileTrak, 
Sunflower Assets employs an approach to managing physical inventories that provides 
unparalleled flexibility, enables multiple inventories to occur at the same time, and drives 
accuracy and accountability into the review process. This chapter will discuss the setup 
preparations of a physical inventory to facilitate the auditing process.
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. .S U N F L O W E R  S E T U P
About Physical Inventory
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A B O U T  P H Y S I C A L  I N V E N T O R Y

The setup of a physical inventory begins within the Sunflower Assets application by creating a 
review campaign in the Review module. Working within the guidelines of your organization’s 
audit cycle (e.g. annual, semi-annual, quarterly, etc.), the following steps are performed by the 
Review Manager to establish a review campaign in Sunflower Assets:

Step 1   Define a campaign: The review campaign establishes the parameters within which you 

intend to conduct your physical inventory (e.g. campaign name, sponsor, start/end 

dates, type of sampling, transaction types, etc.). 

Step 2   Define the baseline: The baseline specifies the group (base) of assets to be accounted 

for within the specified review campaign.

Step 3   Freeze the baseline: Freezing the baseline enables you to perform the review for a 

predefined set of assets against a specified period of time, without being concerned 

about “asset creep” (newly created assets constantly being added to the campaign).

Step 4   Define resolution types: The resolution types indicate the method you intend to use to 

locate and/or validate the assets for your review campaign, (e.g. MobileTrak barcode 

scanning, online declarative, online physical, etc.).

It should be noted that although setting up a review campaign facilitates an efficient and 
organized auditing process, assets that are found and not part of the existing baseline can still 
be scanned (or manually entered) and accounted for using MobileTrak and Sunflower Assets. 
The use of the MobileTrak application does not require a campaign be established in order to 
use the software.

Refer to the Sunflower Enterprise Assets v4.5 User Guide (available for download from 
Customer Care (http://www.sunflowersystems.com) for detailed information on setting up a 
review campaign.
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S U N F L O W E R  S E T U P
About Physical Inventory1  
PH YS I C AL IN VE NT O RY PRO CE SS

The MobileTrak application is equipped with several features to support physical inventories in 
a variety of situations whether the assets are located in a single building, across town, or 
across the country. In addition to recording automated barcode scans (asset reads) on the 
spot, MobileTrak enables you to manually capture information for new assets using the asset 
identifier or the UID (Unique Identifier), as well as make changes to existing assets found in 
the reference database. The following diagram depicts a typical physical inventory process 
using MobileTrak.

Figure 1-2: Flowchart illustrating a typical physical inventory process

Create a Review 
Campaign
(Optional)

Create Base 
Assets

(if applicable)

Freeze the Review 
Campaign

(if applicable)

Conduct Inventory 
(Scan the Assets)

Review Scans in 
MobileTrak on the 
Barcode Scanner

Set up the 
Resolution in 

MobileTrak on the 
Scanner

Send Files from 
the Scanner to the 

Database

Send Sunflower 
Data Files to the 
Barcode Scanner

Review and 
Resolve Errors in 

Sunflower
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. .S U N F L O W E R  S E T U P
About Physical Inventory
MO BI LETRA K BAR CO DE SCA NN I NG PRO CE S S

Sunflower Assets, in conjunction with MobileTrak, provides mobility in the tracking and 
management of your assets. MobileTrak enables field representatives to conduct a physical 
inventory with the use of a hand held barcode scanner. The scanning of an asset not only 
validates that the asset exists, but further documents the asset’s existence by identifying the 
location of the asset and the individual who performed the scanning activity. The following 
flowchart depicts the barcode scanning process using MobileTrak.

Figure 1-3: MobileTrak scanning process
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Sunflower Assets Setup1  
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . S U N F L O W E R  A S S E T S  S E T U P

After the initial installation of MobileTrak 4.6, there are business decisions you need to 
consider regarding which forms and tables to populate before using your barcode scanner(s); 
which include: 

• Force Authorization

• Term Set

• Extend Valid Asset Events (by creating User Defined Fields)

• Maintaining Approvers

• Maintaining Operators

This section discusses the setup requirements, which must be performed by your Sunflower 
Systems Administrator.

NOTE: The Sunflower Assets Functional Foundation (SFA200) course discusses and the 
Sunflower Assets Administration (SFA300) course provide in-depth coverage of the Term Set 
and User Defined Field options.
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. .S U N F L O W E R  S E T U P
Sunflower Assets Setup
FOR CE AU TH OR I Z AT I O N

Force Authorization determines if you can enter the Operator Name on the Barcode Scanner’s 
Asset Read Setup screen or if that data is determined by the user that Logs In to SyncLink. 
The figure below illustrates where to set the Force Authorization parameter values.

The default Value is Y (Yes) which indicates that the Barcode Scanner operator must be 
authenticated. Based upon your Business Policy, select Y (Yes) or N (No) for the Value field.

Figure 1-4: Force authorization parameter setting

As shown above, when you change any factory delivered setting on the Enter Registered 
Application Parameter Values form, the Set? checkbox automatically is enabled (checked).

To revert a line item back to the factory delivered value select (highlight) the line item and click 
the Reset Value button at the bottom of the page.

. . . . . . . . . . . . . . . . . . . 
NAVIGATION

• Click Admin

• Click User Extensibility

• Click Enter Registered 
Application Parameter 
Values

• Enter FORCEAUTH in the 
Code field.

• Click the Find icon.
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S U N F L O W E R  S E T U P
Sunflower Assets Setup1  
TER M SE T

The Term Set (Personalized Application View) feature allows you to change the field names 
visible on the Barcode Scanner (i.e. change Steward to Department, Cost Center, or Project). 
The figure below illustrates where to create and change the Barcode Scanner term set values.

NOTE: If you are not currently using modified Term Sets in your Sunflower instance then you 
must first create a new Term Set value to be able to change terminology as the delivered 
Sunflower Systems term set can not be modified.

.

Figure 1-5: View where you create and change a new term set Value (i.e. BARCODE).

. . . . . . . . . . . . . . . . . . . 
NAVIGATION

• Click Admin

• Click Domains

• Click Maintain Domains

• Enter T% in the Name 
field.

• Click the Find icon.
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. .S U N F L O W E R  S E T U P
Sunflower Assets Setup
Once you create a new Term Set, you can personalize the field names in accordance with your 
Business Policy. The next two figures illustrate how to access and change the field name 
Steward (a default name in Sunflower Assets) to Department.

.

Figure 1-6: Personalize term set field names.

Step 1   In the Term Set dropdown select the newly created Term Set (i.e. BARCODE).

Step 2   Accept the Term radio button default.

Step 3   Click the Search button, which opens the Search Criteria pop-up window.

Step 4   Enter MOB% in the Search Criteria Module field and click the Execute button.

Step 5   Select (highlight) STEWARD NAME, which populates the Term Defaults and Items 
block.

. . . . . . . . . . . . . . . . . . . 
NAVIGATION

• Click Admin

• Click User Extensibility

• Click Maintain 
Terminology
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Sunflower Assets Setup1  
Step 6   Change the term Steward to Department (circled below).

Figure 1-7: View where to make the appropriate changes to change from Steward to Department.

Step 2   Save your changes.

Note: You may need to completely close and then re-open Sunflower Assets in order to see 
the change reflected, especially if you made global changes to the Sunflower Forms as well as 
the Mobile device.

. . . . . . . . . . . . . . . . . . . 
NAVIGATION

• Click Admin

• Click User Extensibility

• Click Maintain 
Terminology
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. .S U N F L O W E R  S E T U P
Sunflower Assets Setup
EX T EN D VA LI D AS S ET EV EN T S

Based upon your Business Policy, extend the appropriate User Defined Fields (UDFs) to 
capture your organization’s unique data. You can create up to 30 UDFs per Context Value 
entry (or _NO_CONTEXT_ as shown in this example).These UDFs will display on the barcode 
scanner Update Asset - Page 2 of 2 page when you scan or manually enter an asset.

This section illustrates where you can extend UDFs. The example illustrates how to add the 
field “Comments” as a UDF which will then display as a field when using MobileTrak. To learn 
more about creating UDFs refer to the Sunflower Enterprise Administration v45 User Guide, 
available for download from the Customer Care center (www.sunflowersystems.com).

Figure 1-8: Extending UDF for mobile application use.

Step 1   Navigate to the Maintain Attribute Sets form, which opens in the Query mode.

Step 2   Click the Find icon once and scroll until ASSET READ UDF displays in the Name field.

Step 3   Click the Next Block icon, which automatically highlights _NO_CONTEXT_.

NOTE: To create new UDFs, you would first change the Frozen? field to N (No) 
and change it back to Y (Yes) when you have completed the attribute definitions.

. . . . . . . . . . . . . . . 
NAVIGATION

• Click Admin

• Click User 
Extensibility

• Click Maintain 
Attribute Sets

• Select ASSET 
READ UDF
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Sunflower Assets Setup1  
Step 4   Click the Next Block icon to go to the Attribute Definitions form and enter the desired 

data.

Figure 1-9: UDF attribute definition form.

Step 2   Click the Exit icon to close the Maintain Display Definitions form.

. . . . . . . . . . . . . . . . 
NAVIGATION

• Click Admin

• Click User 
Extensibility

• Click Maintain 
Attribute Sets

• Select ASSET 
READ UDF

• Select 
_NO_CONTEXT_

• Click the Next Block 
icon

• Click the Display 
button
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. .S U N F L O W E R  S E T U P
Sunflower Assets Setup
Step 3   Click the Validation button (and then click the Cancel button) to display the Maintain 

Validation Definitions form, as shown below.

Figure 1-10: Maintain Definition form.

Step 2   Click the Exit icon to close the Maintain Validation Definitions form.

Step 3   Click the Previous Block icon to return to the Maintain Attribute Sets form.

Note: UDFs created for Organizations and/or People will either have a drop-down or will be 
free text entry, based upon how you establish their Validation.

. . . . . . . . . . . . . . . . 
NAVIGATION

• Click Admin

• Click User 
Extensibility

• Click Maintain 
Attribute Sets

• Select ASSET READ 
UDF

• Select 
_NO_CONTEXT_

• Click the Next Block 
icon

• Click the Validation 
button
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Sunflower Assets Setup1  
The following figure shows an example of a User Defined Field (UDF) named Comments in 
MobileTrak.

Figure 1-11: UDFs extended in the MobileTrak application.

Note: During installation, user code must be established to handle the user defined fields data 
entry when barcode scanned data is sent to the Sunflower Enterprise database. Otherwise the 
user defined field data will be lost during the barcode scanner upload process.

. . . . . . . . . . . . . . . . . . 
NAVIGATION

• Tap Start

• Tap MobileTrak

• Tap Setup and enter the 
appropriate data

• Tap Asset Read and 
enter the appropriate 
data

• Tap the ok button

• Tap the Next button

• Scan or Manually Enter 
an Asset

• Tap the Update button

• Tap the Next button

• Scroll down the page 
until the UDF displays
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. .S U N F L O W E R  S E T U P
Sunflower Assets Setup
MA I N TA I N APP R OV ER S

Use the Maintain Approvers form to allow individuals to Create New Assets or Update Existing 
Assets in the Sunflower database via the Barcode Scanner. Otherwise the new/updated asset 
information will not process through the appropriate interface table (i.e. Edit Inventory Asset 
Interface Records). Regardless of whether a person has been added to this form, the 
Resolution will still occur in the Review module.

• Add individuals to the Maintain Approvers form.

Note: Approvers must already be in the Sunflower Enterprise People table.  
If they are not, select Admin > People > Maintain People and create Person records as 
required. The figure below illustrates how to add individuals to the Maintain Approvers form.

.

Figure 1-12: Maintain Approvers form.

If you do not add an individual to the approver’s list you can still perform a physical inventory 
and do asset reads; however, any data changes would not be allowed and the uploaded data 
would go into the Interface table, awaiting action from a Sunflower Assets user.

. . . . . . . . . . . . . . . . . . . 
NAVIGATION

• Click Admin

• Click People

• Click Maintain Approvers
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Sunflower Assets Setup1  
MA I N TA I N OP E RA TO RS

Use the Maintain Operators form to determine the list of operators in MobileTrak. An operator 
is the person scanning assets. This list of values (LOV) will be available if the FORCEAUTH 
(Force Authorization) parameter is set to No in Sunflower Assets. If Force Authorization is set 
to Yes, then the Scanner Operator defaults to the person that performed the SyncLink Login.

Of note; you can manually enter an individuals name if it is not in the LOV; however, if the 
entry is not in the proper format, then the Resolution data goes into the Edit Resolution 
Interface Records table, awaiting action from a Sunflower Assets user.

Note: Operators must already be in the Sunflower Enterprise People table.  
If they are not, select Admin > People > Maintain People and create Person records as 
required. The figure below illustrates how to add individuals to the Maintain Operators form.

.

Figure 1-13: Maintain Operators form.

This completes the Sunflower Assets portion of the MobileTrak Setup.

. . . . . . . . . . . . . . . . . . . 
NAVIGATION

• Click Admin

• Click People

• Click Maintain Operators
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MOBILETRAK™ SETUP 2

MobileTrak™ is a Sunflower Assets® inventory 
management tool that is deployed via a fully integrated 
barcode reader that records and delivers asset 

information directly to your Sunflower Assets database. By integrating 
Sunflower Assets with mobile computing technology solutions, 
MobileTrak meets the needs of enterprises that track and manage 
assets using various types of data collection technologies such as 
traditional bar codes, 2D data matrices, and Radio Frequency 
Identification (RFID) tags. MobileTrak records and then delivers your 
inventory data back to Sunflower Assets on demand.

This chapter will include the following discussion points and concepts:

• MobileTrak Overview

• Preparing to Use MobileTrak

• Launch MobileTrak

• MobileTrak Icons

• MobileTrak System Utilities

• Terminate a MobileTrak Session

M
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M O B I L E TR A K ™  S E T U P
MobileTrak Overview2  
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . M O B I L E T R A K  O V E R V I E W

By integrating Sunflower Assets with mobile computing capabilities, MobileTrak meets the 
needs of enterprises that track and manage assets using various types of data tracking 
methods such as 1D barcodes, 2D data matrices (Marks), and/or RFID tags. MobileTrak 
records inventory data gathered in the field during a physical inventory and then delivers the 
data back to Sunflower Assets on demand. The benefits of using mobile computing 
capabilities to manage your physical inventories include:

• Immediate notification of asset status, asset additions, reviews and/or deletions, and 
additional details such as the individual who performed the scanning activity and the 
asset’s location.

• The capability to transfer (download/upload) multiple assets in one action.

• Advanced filtering capabilities allows for specific sites, campaigns, stewards, agreements, 
or any combination of these four choices to be transmitted into the core reference file, 
which provides complete accuracy of each inventory.

• File transfers through standard protocols gives MobileTrak users the capability to transmit 
inventory files directly to a central location using STMP protocols rather than conducting 
multiple file uploads.

MobileTrak includes all of the files needed to perform a physical inventory with your barcode 
scanner, which includes the files that populate drop-down lists in the barcode scanner 
application and an asset reference database. Identification of an asset for physical inventory 
begins by defining a review campaign in Sunflower Assets. Once the campaign is defined, the 
reference data is downloaded from Sunflower Assets to the scanner. The scanner can then be 
used to locate and scan the asset’s barcode, called the Identifier, which identifies the asset in 
the same manner as a social security number identifies one person from another. Additionally, 
MobileTrak is capable of handling manual entry of asset identifiers and unique identifiers 
(UIDs) directly into the scanner if a barcode is damaged or unscannable.

Note: You have the option of connecting your Barcode Scanner base via USB or Ethernet. 
Ethernet requires additional setup. If using the Ethernet, connect the USB just to create a 
Partnership and then disconnect the USB cable. Contact the Sunflower Helpdesk for details. 
The Sunflower Helpdesk can be reached at:

Phone: 1-866-209-3516

Email: helpdesk@sunflowersystems.com
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. .M O B I L E TR A K ™  S E T U P
MobileTrak Overview
PR ER EQ UI S I TE  FO R SU NF L OWE R MO BI LETRA K

This guide assumes that the MobileTrak application has been installed onto the requisite 
handheld scanner(s) and that the appropriate patches have been installed in the Sunflower 
Assets 4.5 application.

For more information about the installation process refer to the MobileTrak Installation guide 
located in Product Downloads on the Sunflower Customer Care website: 
http://www.sunflowersystems.com.
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M O B I L E TR A K ™  S E T U P
Preparing to use MobileTrak2  
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . P R E P A R I N G  T O  U S E  M O B I L E T R A K

Prior to using the MobileTrak application for the first time in the field, it is necessary to perform 
a few configuration steps to ensure the appropriate assets and reference data are available 
during a review campaign. These steps include:

Step 1   Create a Partnership (Standard or Guest) using Microsoft ActiveSync.

Step 2   Launch Sunflower SyncLink (login to the Sunflower Assets application).

Step 3   Determine the interest asset type or type(s) to be inventoried.

Step 4   Optionally apply data filters.

Step 5   Determine data to be transferred to the mobile application:

• All or selected Catalog data

• All or selected People data

• All or selected Managers

• All or selected Stewards

Step 6   Transfer data and look up files from the Sunflower database to the mobile application.
2 -26 Sunflower MobileTrakTM User Guide 4.6 Sunflower Systems © 2008 April



. .
 . 

. .M O B I L E TR A K ™  S E T U P
Preparing to use MobileTrak
CRE AT E A PAR TN ER S HI P  US I N G MI C RO S OF T ACT I V ESYN C

If you will be sending a large amount of data to the scanner based on your number of assets, 
organizations, people, and catalogs then you should use an ethernet connection to the cradle 
(see “Ethernet Connection” below). 

Of note, you will normally use a Standard Partnership with an ethernet connection to the cradle 
and typically use a Guest Partnership when using a USB connection to the cradle (see “Serial 
Port/USB Connection” on page 2 -37).

The following guidelines are provided based on the setup required for an Intermec (model: 
700c) scanner. This process applies to all scanners that provide an ethernet connection but 
other scanners may have slight variances in their configuration screens.

E T H E R N E T  C O N N E C T I O N

Setting up activesync to work with an ethernet connection will enable you to upload and 
download asset records in a shorter period of time as compared to a standard serial port/USB 
connection. The basic steps required include:

1. Create a partnership.

2. On your desktop, or laptop computer, change the Microsoft ActiveSync connection setting 
to enable an Ethernet connection from your PC.

3. On your scanner, update the options in ActiveSync to enable an Ethernet Connection 
from the scanner.

The following steps will guide you through the specific setup steps.
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Preparing to use MobileTrak2  
P A R T  1 :  C R E A T E  A  P A R T N E R S H I P

There are five steps required to create a partnership with an Intermec scanner running the 
Pocket PC operating system and using ActiveSync version 4.5. Note that the steps that you 
follow may vary slightly if you are using a different version of ActiveSync. 

Step 1   To create a partnership connect the USB cable from the Intermec scanner to your PC 

that has Microsoft ActiveSync installed. A window will display asking you the type of 

partnership that you want to create. Select the Standard partnership radio button. 

Click the Next button
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. .M O B I L E TR A K ™  S E T U P
Preparing to use MobileTrak
Step 2  Specify how to synchronize the data. Select the Synchronize with this desktop computer. 
Click the Next button
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Preparing to use MobileTrak2  
Step 3  Create partnerships. Select Yes, I want to synchronize with only this computer. Click the 
Next button.

Step 4  Select the synchronization settings. Remove the check marks from every application in 
the Mobile Device column. Remember to scroll the window down using the scroll bar at 
the left of the window and remove the check marks from every application. Click the 
Next button.
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. .M O B I L E TR A K ™  S E T U P
Preparing to use MobileTrak
Step 5  The next step completes the setup. Click the Finish button.

• Activesync makes the synchronization connection. 

• The ActiveSync window will display. Synchronization is taking place between your desktop 
and the scanner. Synchronization may take a few minutes; when it is complete, Connected 
and Synchronized display in the window, see picture below.

• Now you may disconnect your USB port.

P A R T  2 :  Enable An Ethernet Connection From Your PC

In the following section use your desktop, or laptop computer, to change the Microsoft 
ActiveSync connection setting to allow an Ethernet connection. 

Step 1   From your PC, open the Microsoft ActiveSync window. 

• You may have the window open based on the last step of the previous instruction 
describing how to create an Ethernet connection. 

• You may need to double click the ActiveSync icon in your system tray (a round icon either 
grey or green with two arrows going in a circle). 

• You may need to select Start -> Programs and find ActiveSync.
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Step 2   From the ActiveSync window click the File menu then click Connection Settings. 
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Preparing to use MobileTrak
Step 3  In the connection settings check the box next to Allow network (Ethernet) and Remote 
Access Service (RAS) server connection with this desktop computer.

Step 4  Click OK.
Sunflower Systems © 2008 April Sunflower MobileTrakTM User Guide 4.6 2 -33



M O B I L E TR A K ™  S E T U P
Preparing to use MobileTrak2  
P A R T  3 :  E N A B L E  A N  E T H E R N E T  C O N N E C T I O N  F R O M  T H E  S C A N N E R .

The following discussion will address how to enable an ethernet connection from your 
handheld barcode scanner.

Step 1   Connect the ethernet cable to your cradle or scanner. 

Step 2   Remove the scanner from the cradle. Tap Start and then tap ActiveSync from the 

scanner menu.

Step 3   Select Tools, then select Options, and choose to Sync with this PC during manual sync. 

• Notice that Use this PC has the name of the PC that was used to create a partnership.
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Step 4  Then select the Options button and select the Maintain connection radio button and click 
OK.

Step 5  Tap the Sync icon (located in the middle of the window with a green round icon with two 
arrows).
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R E - I N I T I A T E  A N  E T H E R N E T  C O N N E C T I O N

If for any reason you are required to perform a hard boot on your PC or your scanner the 
ethernet connection will be broken. To reconnect the ethernet connection perform the 
following.

Step 1   From the scanner, tap Start, then tap Settings.

Step 2  Tap the Connections tab.

Step 3  Tap the Connections icon.

Step 4  Tap the Advanced tab.

Step 5  Tap the Select Networks button.

Step 6  In the first dropdown, select the My work Network option from the list of values.

Step 7  Tap OK.

Step 8  Go to Activesync and select the Sync icon.

For additional consideration refer to the installation instructions for additional details regarding 
the ethernet connection.

An alternative connection option is the use of a USB connection.
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S E R I A L  P O R T / U S B  C O N N E C T I O N

If you are using a USB connection, refer to the following discussion.

Microsoft® ActiveSync® is a tool used to join together the file transfer capabilities of Sunflower 
SyncLink™ with the mobile computing capabilities of MobileTrak™. When the barcode scanner 
is connected to your computer, it searches for ActiveSync. Select Guest partnership unless 
you are the only individual to use this barcode scanner and then click the Next button.

Figure 2-1: ActiveSync Partnership
Sunflower Systems © 2008 April Sunflower MobileTrakTM User Guide 4.6 2 -37



M O B I L E TR A K ™  S E T U P
Preparing to use MobileTrak2  
In a connected state, ActiveSync enables communication between SyncLink and MobileTrak 
for successful data transfer between the files in the Sunflower database and the MobileTrak 
application. There is no data entry required in ActiveSync, except to select the appropriate 
Partnership. The ActiveSync dialog box will display information to verify the computer and 
barcode scanner connection, as shown below. 

Figure 2-2: ActiveSync Connection Status

Step 1   Connect the scanner (cradle) to your computer.

Step 2   Turn on the scanner, which automatically launches (opens) Microsoft ActiveSync.

Step 3   Set up a partnership; Guest is recommended, unless you are the only barcode user.

Step 4   Click the Next button to display the ActiveSync status window, shown above.

Step 5   Once Connected, minimize or close the ActiveSync window.

Note: Once connected you may minimize or even close the ActiveSync window. If you close it, 
you will notice an ActiveSync icon remains open (active) in the tray of your Windows Task bar.
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LAU NC H SY NCLI N K

SyncLink is used to transfer (download) asset data from your Sunflower Assets database to 
your handheld barcode scanner containing the MobileTrak application. Synclink is also used 
to send asset data from your handheld barcode scanner back to your Sunflower Enterprise 
database. SyncLink must be used to send files to the scanner and retrieve files from the 
scanner.

When you log into SyncLink, Sunflower Enterprise is used to validate the permissions a user 
has according to how the user has been set up in the application’s Administration module. For 
example, if a user has logged into SyncLink as an Inventory Manager, then the user is 
authorized to change all inventory assets. However, if the user is set up as an Inventory Clerk 
or Asset Center Representative, then the user is only authorized to change assets for the 
steward organization to which they are assigned as an Organization Contact.

Step 1   If available, double click the SyncLink icon on your desktop to open Sunflower 
SyncLink or navigate to the SyncLink.exe file to launch SyncLink.

Step 2   Enter your Sunflower Username and Password.

Step 3   Click the Login button.

Figure 2-3: Login to SyncLink using Sunflower Enterprise

Note: Sunflower Enterprise is used to validate role permissions available to the person logging 
in. This means that all of the rules used in Sunflower Enterprise pertaining to roles and 
appropriate authorization are also applicable in MobileTrak.
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ABOU T LO OK UP F I LE S

To start MobileTrak on a barcode scanner, data must first be loaded from the Sunflower 
Assets (SFA) database. The data from Sunflower Assets includes the assets and the 
reference data used to populate drop down lists for fields such as sites, structure levels, 
steward, manager, custodian, user, and the asset catalog to name a few.

In order to work with the Sunflower Assets (SFA) data you will use SyncLink as the conduit to 
transfer data between SFA, your PC, and the barcode scanner for use with the MobileTrak 
application. When new data such as a catalog entry, site, structure level 1 type, structure level 
2 type, or interest asset is added to your Sunflower Assets database, you will perform the 
following actions to update the MobileTrak application: Load lookup files, Select the interest 
asset type or types, and Send the data to the barcode scanner.

Note: If left unchecked (default setting) only the catalog, people, manager, and steward entries 
associated with your selected assets are transferred to the barcode scanner.

To facilitate the transfer process the following table describes checkboxes that are available in 
SyncLink: 

CHECKBOX DESCRIPTION/EXPLANATION

Download

Defaults. Used to transfer data from the Sunflower Assets (SFA) database to your Desktop or 
Laptop PC during the Send To Scanner process.
Note: If you have multiple Barcode Scanners supporting your Physical Inventory; transfer the 
data to the first Scanner with the Download checkbox enabled (checked), which loads the 
reference files onto your PC, then after the transfer to the Scanner is complete:
  •  Uncheck the Download checkbox, leaving the Copy to Scanner checkbox checked.
  •  Place another Barcode Scanner in the Cradle, create a partnership, and click the Send to 

Scanner button.
  •  Repeat as required for each additional Barcode Scanner.
This feature allows you to transfer the same data to multiple Scanners quicker and easier.

Copy to Scanner Defaults. Used to transfer data from your PC to your Barcode Scanner during the Send To 
Scanner process.

Include All Catalogs
Check only if you wish to transfer ALL SFA Catalog (Manufacturer, Model, and Official Name) 
data to the Barcode Scanner.
Note: The Catalog data needed to support your current asset base is automatically transferred.

Include All People
Check only if you wish to transfer ALL SFA People data (from the People Records in the Admin 
module) to the Barcode Scanner.
Note: The People Record data needed to support your current asset base is automatically 
transferred.

Include All Managers
Check only if you wish to transfer ALL SFA Manager data (from the Organization table 
maintained in the Admin module) to the Barcode Scanner.
Note: The Manager data needed to support your current asset base is automatically transferred.

Include All Stewards
Check only if you wish to transfer ALL SFA Steward data (from the Organization table maintained 
in the Admin module) to the Barcode Scanner.
Note: The Steward data needed to support your current asset base is automatically transferred.
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SE L EC TI NG T HE IN TE R ES T AS SE T TY PE

Selecting an interest Asset Type will tell Sunflower Assets from which Module or “Interest” the 
assets are going to be scanned. Essentially, the interest asset type is an umbrella under which 
a group of assets are housed such as all Inventory assets or all Excess assets.

New with MobileTrak Release 4.6 you may send and scan multiple asset types (modules) at a 
time.

Figure 2-4: Interest Asset Types. Selecting an asset type identifies the interest assets that will be retrieved from 
the Sunflower Assets database and downloaded to the barcode scanner.

Use the steps on the next two pages to setup SyncLink.
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Step 1   Launch SyncLink by double-clicking SynkLink.exe or the SyncLink icon on your PC. 

Step 2   Enter your Sunflower Assets Username and Password, and then click the Login button.

Step 3   Accept the default settings for the Download and Copy to Scanner checkboxes; at least 
for the first Barcode Scanner. Then if desired, uncheck the Download checkbox.

Step 4   Select the desired “Include” checkbox(es) per your Business Policy.

Step 5   Select the Asset Type(s) for which you are conducting the inventory (i.e. Inventory).

Step 6   Select MobileTrak from the list of applications by clicking on the name to highlight it. 

Figure 2-5: Application Name. Selecting an application identifies to SyncLink the mobile computing tool you 
wish to use, whether it is MobileTrak™, PackTrak™, or ExcessTrak™. In the figure above only one application 

has been installed, if there were other mobile applications installed they would be visible here.

The next page discusses the optional filtering that is available in Synclink.

. . . . . . . . . . . . . .
NAVIGATION

• Select the 
appropriate 
checkboxes

• Select the asset 
type(s)

• Select the 
MobileTrak 
application 
name

• Optionally click 
the Filter button

• Click the Send 
To Scanner 
button
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F I L T E R I N G  A S S E T  D A T A  ( O P T I O N A L )

The last step in completing the configuration of MobileTrak for a review campaign involves 
applying any special filters to the asset data in accordance with your organization’s business 
processes. As this is an optional step, it is not required to ensure the success of your barcode 
scanning operations.

Using a filter serves to narrow the assets you expect to find during a physical inventory to a 
particular site, steward, manager, agreement, campaign, or any combination of these filter 
selections. You may select more than one entry from each tab.

Figure 2-6: Filters can be applied for specific Sites, Agreements, Review Campaigns, and/or Stewards

Note: If filtering is selected the Filter button will be activated, changing from Gray to Blue.

. . . . . . . . . . . . . . 
NAVIGATION

• Click the Filter 
button 

• Select a tab(s) 
containing the 
filter(s) to be 
applied

• Select the 
appropriate data

• Click the Apply 
button

• Click the OK 
button
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Step 3   Click the Send To Scanner button to transfer reference and asset files to your PC and 
on to the barcode scanner.

Figure 2-7: Download to the PC and Copy to the Barcode Scanner pop-up window.

A pop-up window displays, shown above, reminding you to shutdown MobileTrak before 
transferring the data from the Sunflower Assets database.

Step 4   Click the OK button on the pop-up window, which will start the transfer process.
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Step 5   A Download and Copy Complete pop-up window displays, as shown below, which 

means that the Download to the PC and the Copy to the Scanner are both complete.

Figure 2-8: Download to the PC and Copy to the Barcode Scanner pop-up window.

Step 6   Click the OK button on the pop-up window.

Note: You have the option to place additional Barcode Scanners into the cradle, create 
another Guest Partnership, uncheck the Download checkbox, and click the Send To Scanner 
button. You may copy the data to as many Barcode Scanners as required.
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TRA NS F ER RI N G A ND T HE DA TA BA S E REF RE S H PR OC ES S ES

T R A N S F E R  ( D O W N L O A D )  D A T A  F R O M  T H E  D A T A B A S E  T O  T H E  B A R C O D E  
S C A N N E R

The transfer of data between your Sunflower Assets database and MobileTrak involves a 
number of interactions between the various components of the barcode solution. The following 
diagram outlines the main components and the interactions between them. 

Figure 2-9: Transfer process

You may also interact with MobileTrak using HTML pages. The scanner must be docked in the 
cradle and the cradle connected to your computer. At a high level, the following automated 
steps are executed to download asset data from the database to the barcode scanner when 
you click the Send to Scanner button. The Send To Scanner process involves a number of 
interactions between the various components of the barcode solution. These interactions 
include copying reference files from the Sunflower Application to the PC, then copying the files 
from the PC to the scanner.

Step 1   Transfer data from the server for the lookups and reference files to the PC.

Step 2   SyncLink stores the data from the SFA database on the PC.
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Step 3   Copy the new reference files, collectively known as the reference database, to the 

barcode scanner. To avoid any conflicts, SyncLink first removes the existing 

reference database from the barcode scanner (Number 3).

D O W N L O A D  T I M E - O U T S

SyncLink waits for each file to be downloaded before sending the files to your barcode 
scanner. SyncLink is capable of detecting when all of the files have been successfully 
downloaded and automatically resumes operation. Although SyncLink strives to ensure 
downloads happen as expected, it cannot anticipate some exceptional situations. For 
example, if you cancel the download of a file or change the default Save-to location, SyncLink 
will not be able to find the downloaded file.

When confronted with a situation similar to this, SyncLink waits a specified period before 
prompting you to restart the wait period or cancel the process. The default value for the time 
out is 30 seconds, but can be changed to a longer period if necessary. If you receive this 
notification and you have not yet finished acknowledging the download dialog boxes, clicking 
“Yes” will instruct SyncLink to continue waiting. If you have acknowledged all the file download 
dialog boxes, the notification indicates that at least one download has failed. You must repeat 
the entire download process to ensure that all of the files have been downloaded and 
transmitted to your barcode scanner.

T R A N S F E R  ( U P L O A D )  D A T A  F R O M  T H E  B A R C O D E  S C A N N E R  T O  T H E  
D A T A B A S E

Step 4   The Get From Scanner button is used to copy the MobileTrak output data file from the 

barcode scanner to your PC (Number 4). You will need to ensure the MobileTrak 

application is not in use prior to performing the upload.

Step 5   SyncLink assembles the data for delivery to the SFA database.

Step 6   Upload the data to the application server and invoke server side components that will 

insert the updated records into your Sunflower Assets database (Number 6).

Upon completion of the configuration steps, you are ready to begin using MobileTrak.
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This section will discuss how to launch and setup MobileTrak. Of note, there are a wide 
number of barcode scanners available, however, the process of using MobileTrak release 4.6 
is the same regardless of the scanner in use.

Step 1   Tap, using the “Stylus” provided, Start on the barcode scanner touch screen.

Step 2   If available, Tap the MobileTrak icon located just below the Start menu. 
 
Alternatively, you can Tap Start > Programs > MobileTrak.

Figure 2-10: Launch MobileTrak using the Start menu on the barcode scanner

Tips: If, when starting MobileTrak, you receive an error message, then you do not have the required 
lookup files loaded on your barcode scanner.

Run the SyncLink procedure described previously. If the MobileTrak main menu displays then 
you have successfully loaded and initialized the barcode scanner with your lookup files.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start

• Tap the 
MobileTrak 
icon 
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MO BI LETRA K PR OG RE SS BA R

After launching MobileTrak, a Progress Bar automatically displays, as shown below.

Figure 2-11: MobileTrak Progress Bar

You must wait until the Progress Bar action is complete before proceeding any further.

Once the Progress bar action is complete, the MobileTrak main menu displays icons, which 
replaced the lists of menu actions available in previous versions, representing various 
functions and new terminology.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start

• Tap the 
MobileTrak icon 
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . M O B I L E T R A K  I C O N S

A new feature of MobileTrak v4.6 is the improved ease of use and navigation made possible 
through icons. The icons replace the lists of menu actions available in previous versions of the 
application. Additionally, the icons represent new terminology as represented in the table 
below.

MobileTrak icons:

System Utilities icons:

Figure 2-12: MobileTrak icons

Setup Asset Read

Asset Receiving Transaction 
Counts

Review Scans Sign Off

Exit

Battery Status Test Scanner

Thermal Info Set Clock

Memory Status
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . M O B I L E T R A K  S Y S T E M  U T I L I T I E S

MobileTrak has a number of features available through its System Utilities to assist you in the 
management of the application with common tasks such as setting the clock on your barcode 
scanner, setting alarms, checking the battery status, and testing the scanner. The following 
system utilities are available in the MobileTrak application: 

• Battery Status

• Test Scanner

• Terminal Info

• Set Clock

• Memory Status

All of the features listed above are available on the System Utilities tab of the MobileTrak 
application, as shown below. 

Figure 2-13: System Utilities tab
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BAT TE R Y ST AT U S

The Battery Status feature is used to monitor and manage usage of the scanner’s battery, 
configure battery runtime, and setup and/or disable low battery notifications. It is important to 
monitor battery setup and usage so that data will not be lost in the event the scanner is 
operated in a low battery condition.

B A T T E R Y  P O W E R

The Power tab is used to monitor the charging status of the main and backup batteries. 
Additionally, this tab is used to set parameters on the time limits for keeping the device 
powered when not in use, whether it is used on battery or external power. 

Figure 2-14: Battery Status. Power Settings

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Battery 
Status
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B A T T E R Y  R U N T I M E

The Battery tab is used to configure the application’s use of the battery runtime. If you choose 
to increase the battery runtime, however, it will decrease RAM retention time and/or 
performance. 

Figure 2-15: Battery Status. Battery Runtime

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Battery 
Status

• Tap the Battery 
tab
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B A T T E R Y  N O T I F I C A T I O N S

The Notifications tab is used to disable low battery notifications on the application. The 
application is setup by default to provide you with two warnings.

1 The first warning occurs when the main battery is running low.

2 The second warning is more serious and will appear when the main battery is 

running very low.

You can choose to disable these notifications, however, this is not recommended because you 
will receive no warning if the scanner is operating in a low battery condition and data could be 
lost.

Figure 2-16: Battery Status. Battery Notifications

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Battery 
Status

• Tap the 
Notifications tab
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TES T SCA NN ER

The Test Scanner feature can be used to test the scanner prior to scanning actual barcodes or 
RFID tags during a physical inventory. If you believe the scanner is not operating properly, this 
feature provides a way for you check the application’s asset read feature without recording 
scans against a physical inventory. 

Figure 2-17: Test Scanner
 
When you scan an asset’s barcode or RFID tag, the information will appear in the blank box to 
confirm the tag has been successfully scanned, as shown below. 

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Test 
Scanner 

• Scan a barcode 
or RFID tag to 
test the scanner 
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TER MI N AL IN F O

The Terminal Info feature is an information-only screen that contains data about the Terminal 
ID of the scanner being used and the type of connection being used for communication with 
ActiveSync. Recall that ActiveSync enables communication between SyncLink and 
MobileTrak for successful data transfer between the files in your database and the MobileTrak 
application. 

Figure 2-18: Terminal Information

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Terminal 
Info 
Sunflower Systems © 2008 April Sunflower MobileTrakTM User Guide 4.6 2 -57



M O B I L E TR A K ™  S E T U P
MobileTrak System Utilities2  
SE T CL OC K

The Set Clock feature assists you in setting the time zone the application will use when 
recording time and date-sensitive information on asset scans. This feature also has the 
capability to allow the user to set four different alarms as reminders to take action on a specific 
task, which could be valuable during a physical inventory with time-sensitive requirements.

T I M E  T A B

The Time tab is used to set the Home clock, which is the clock used on the actual scanner. In 
the event you are conducting multiple physical inventories in other locations, a Visiting clock 
can also be set to help you track the date and time in another location. Use the drop down 
menus on the Time tab to set or change the time zone, time, and date.

Figure 2-19: Set Clock. Time Tab

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Set Clock 
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A L A R M S  T A B

The Alarms tab can be used to set up to four different alarms. When an alarm is sounded, you 
have the option to dismiss it or snooze for a specified time using a drop down list of choices in 
minutes. You can also configure the alarm(s) to play a choice of sounds, and disable or enable 
the default message, flashing light, or vibration. 

Figure 2-20: Set Clock. Alarms Tab

Tap the  icon to set and/or adjust the alarm sound, message, flashing light, and vibration.

Tap the time display  to set the time of the alarm.

Tap the  field and use the pop up keyboard to enter a name for the alarm. 

Tap on a day of the week to set the day the alarm should appear . You 
can set the alarm to go off on multiple days if desired; simply tap the appropriate day(s) of the 
week.

When you have set the desired alarms, you can choose to enable or disable the alarms by 
selecting or deselecting the checkbox next to the appropriate alarm(s).

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Set Clock

• Tap the Alarms 
tab
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ME MO RY ST AT US

The Memory Status feature is used to temporarily adjust the allocation of storage and program 
memory on the barcode scanner. Memory is managed automatically with MobileTrak, 
however, this feature can be used to make adjustments as needed.

M A I N  T A B

The Main tab is used to adjust how storage and program memory are allocated to support the 
application. Move the slider to make adjustments to the application memory allocations. 

Figure 2-21: Memory Status. Main tab

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Memory 
Status 

• Adjust memory 
allocation using 
the slider

• Click OK to save
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S T O R A G E  C A R D  T A B

The Storage Card tab is used to display the ratio of in use memory to free memory. Use the 
drop down menu below the memory bar to switch between ratios for Flash File Store and 
SDMMC Disk store.

Figure 2-22: Memory Status. Storage Card Tab

This is an information-only screen, therefore no data entry is required.

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Memory 
Status 

• Tap the Storage 
Card tab
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R U N N I N G  P R O G R A M S

The Running Programs tab displays the programs available on the scanner. It is similar to the 
Windows Task Manager on your PC. You can activate or stop a program from running by 
highlighting it in the Running Program List and choosing the Activate or Stop buttons, 
respectively.

Figure 2-23: Memory Status. Running Programs Tab

Note: The  link is discussed on the next page.

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Memory 
Status 

• Tap the Running 
Programs tab
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R E M O V E  P R O G R A M S

Use the  link to free storage memory by eliminating listed programs from 
the scanner’s available memory. 

Figure 2-24: Remove Programs feature

Highlight an application in the Remove Programs list and click the  button 
to eliminate the application from the scanner’s storage memory. 

. . . . . . . . . . . . . .
NAVIGATION

• Tap the System 
Utilities tab

• Tap Memory 
Status 

• Tap the Remove 
Programs link
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . T E R M I N A T E  A  M O B I L E T R A K  S E S S I O N

When you want to terminate a MobileTrak session, you can do so in two different ways, 
depending on how you have configured Sunflower Enterprise to authenticate MobileTrak 
users. The two options that are available include: 

• Sign Off

• Exit

SI G N OF F MOB I L ETR AK

The Sign Off feature in MobileTrak is used to indicate a particular user is no longer the 
Operator of the barcode scanner. Sign Off is only an active feature if the FORCEAUTH 
parameter is set to Yes in the Administration module of your Sunflower Enterprise database. 
When FORCEAUTH = Yes the person who logs into SyncLink will be the Operator in 
MobileTrak and you cannot change the Operator ID. When you click the Sign Off icon, a 
prompt will inform you that signing off will require you to reauthenticate with SyncLink. If you 
want to terminate the MobileTrak session, select Yes. Select No to return to the main menu. 

Figure 2-25: Sign Off MobileTrak

. . . . . . . . . . . . . .
NAVIGATION

• Tap the Sign Off 
icon on the main 
menu 

• Select Yes or 
No as 
appropriate
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Terminate a MobileTrak Session
EX I T  MOB I L ETR AK

The Exit feature does not require reauthentication in SyncLink. When you click the Exit icon on 
the main menu in MobileTrak, you are effectively telling the database there is no change in the 
operator of the barcode scanner, but you wish to terminate the session. This contrasts with 
Sign Off, which is used to terminate the session of a specific user.

Figure 2-26: Exit MobileTrak

. . . . . . . . . . . . . .
NAVIGATION

• Tap the Exit icon 
on the main 
menu 

• Select Yes or 
No as 
necessary
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MANAGE ASSET READS 3

Performing a physical inventory using a barcode scanner is 
accomplished in several quick and easy steps that begin with 
using MobileTrak™ for the creation and definition of the 

scanning process. The barcode scanning process using MobileTrak 
entails the synching of data between your Sunflower Assets® 
database and your barcode scanner. MobileTrak will scan your 
assets and record resolutions which are then uploaded to Sunflower 
Assets. This chapter will discuss the process of performing a physical 
inventory using a barcode scanner with MobileTrak installed. 

This chapter will include the following discussion points and concepts:

• Asset Read Overview

• About Asset Read Setup

• Record Asset Reads

• Perform Asset Receiving

• Review Transaction Counts

• Review Scans

P
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A S S E T  R E A D  O V E R V I E W

Sunflower Assets, in conjunction with MobileTrak, provides mobility in the tracking and 
management of your assets from acquisition through final disposal. An asset will likely be 
audited through a series of physical inventories before it is disposed. Assets tracked through a 
physical inventory will go through the following stages in Sunflower Assets and MobileTrak.

Figure 3-1: The chart above identifies the actions related to physical inventories that are performed in 
Sunflower Assets, MobileTrak, or both.

Users that are a part of the physical inventory process can create resolutions for assets 
manually by entering the information through a Sunflower Assets form, through the use of 
Sunflower Assets’ HTML Transaction web pages, or by using a barcode scanner to record 
asset reads.

Performing asset reads, also referred to as recording resolutions, is the process of using a 
barcode scanner to collect data about the assets in your physical inventory. The barcode 
scanner simplifies the scanning of assets for inventories and allows you to:

• Add, edit or delete asset scans

• Add assets found during a scan

• Review previously recorded scans

Physical Inventory Lifecycle Sunflower Assets MobileTrak

1. Define assets in a campaign (baseline) X

2. Freeze baseline X

3. Define parameters for an asset find (resolutions) X

4. Perform asset reads (resolutions) X X

5. Review asset reads X X
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. .M A N A G E  A S S E T  R E A D S
Asset Read Overview
ABOU T AS SE T RE AD SET UP

This section illustrates how to setup asset reads using the MobileTrak screens. Before you can 
begin scanning and recording (asset reads), you must first provide the application with the 
following basic information:

• Operator for the barcode scanner

• Structure Level 1 Type

• Structure Level 2 Type

The Asset Read Setup screen is used to specify background information related to the assets 
that will be scanned. The drop down menu values must be loaded onto the barcode scanner 
the first time you use MobileTrak and may be refreshed periodically to provide new values that 
are added in Sunflower Enterprise. The elements displayed below are updated any time there 
is a new Structure Level Type or Operator added to the Sunflower Enterprise database. The 
update will occur each time files are sent to the scanner. Once values are loaded from the 
reference database, you will be able to define the setup menu by selecting values from the 
drop down list or entering valid values for each field.

Figure 3-2: Asset Read Setup screen.

. . . . . . . . . . . . . . . . .
NAVIGATION

• Tap the Start icon 

• Tap MobileTrak 

• Tap the Setup icon
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O P E R A T O R  N A M E

The Operator Name field contains unique alphanumeric user code defined by your 
organization and name data that represents the user performing the scanning activity. This 
field may autopopulate based on a parameter set in Sunflower Assets. If it does autopopulate, 
it is set to the person that logged in with SyncLink.

To change the user, you must:

• Have the new user log in to SyncLink and do a Send To Scanner, or

• Select the new user from the LOV, which is populated from the Maintain 
Operators form in the Sunflower Assets Admin module.

The Operator Name is a required field used to setup the resolution.

If the Operator Name field is blank, use one of the following data entry methods to display the 
name (or populate a list of values (LOV) that you may then select the name from):

1 Operator Identifier (usually the Employee Number or Badge Number) + Find

2 One comma (,) followed immediately (no spaces) by the Last Name + Find 
(For example: ,smith)

3 Two commas (,,) followed immediately (no spaces) by the First Name + Find 
(For example: ,,alice)

Note: You must Tap the Find icon to initiate the search. If you are using an Intermec scanner, 
the Action key works the same as the Find icon.

Based upon your search criteria, Sunflower will either populate the Operator Name field or 
provide a LOV. If there are greater than 5,000 operators Sunflower will populate only the first 
5,000 returns for you to select from in either ID order, Last Name order, or First Name order 
depending on whether you used commas to enter a last name or first name prior to Tapping 
the Find key.

There are also audio tones incorporated into MobileTrak, which provide an indication of 
whether the data is found or not found.
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Asset Read Overview
S T R U C T U R E  L E V E L  T Y P E S

Structure Level Types are used to provide flexibility when describing structures and parts of 
structures.

Figure 3-3: Structure Level Types

Structure Level 1 and 2 Types:

Structure Level 1 (Stlv1) Type identifies higher level structures (i.e. buildings, warehouses, 
containers, ships, etc.). The structures are defined in the Sunflower Enterprise Administration 
module and the reference data is included in the files sent to MobileTrak. Select from the LOV.

Structure Level 2 (Stlv2)Type identifies a substructure such as a floor, room, wing, or drawer in 
which assets may be stored. This Structure Level Type provides a second level of detail for the 
storage location of your asset and is also included in the files sent to MobileTrak. Select from 
the LOV.

Figure 3-4: Structure Level 1 and Structure Level 2 Types

NOTE: These are required fields. You will enter the actual value of the structure (i.e. 
BUILDING 100 ROOM 1101) in the next menu items.

Structure Level 1:
Building 100

Structure Level 1:
Building 200

Structure Level 2:
Room 1101

Structure Level 2:
Room 1201

Structure Level 2:
Room 2101

Structure Level 2:
Room 2201
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S C A N  &  G O

The Scan & Go feature allows you to perform continuous scanning (asset read) activity where 
you prefer not to view the details of each scanned asset.

Note: If you select (check) the Scan & Go checkbox the scanner will not display asset details 
and the Update or Add features on the Asset Reads screen will not be available.

Note: If, in SyncLink, you selected multiple Interest Types (i.e. Inventory Management and 
Agreements), have two different assets with the same Barcode Identifier, and the asset you 
scan has one of those barcodes, then the Barcode Scanner will automatically drop the Interest 
Identifier (i.e. INV or AGR). When you open SyncLink and perform the Get From Scanner 
process the following will occur:

• The resolution will go to the Auxiliary Load Resolutions Table, which is not 
accessible from Sunflower Assets.

• When you run the Resolution Interface Processing Report, an error will display.

• Notify your Sunflower Assets DBA, who can then relocate this error into your 
Review Resolutions Interface table for your resolution.

R F I D  U S E

MobileTrak, in conjunction with Sunflower Enterprise, is capable of supporting physical 
inventory efforts for assets utilizing Radio Frequency Identification (RFID). Sunflower 
MobileTrak can accommodate simultaneous multi-tag RFID scanning, thereby making it 
possible to scan more than one asset in a given location with one push of the scanner button.

If your organization utilizes RFID technology for its assets, selecting the RFID checkbox will 
initialize the devices required to enable MobileTrak to read RFID scans. When MobileTrak is 
started the first time, the RFID checkbox will default to the deselected (unchecked) state.

Note: If you will be using RFID, then you must check the RFID checkbox and restart 
MobileTrak. When MobileTrak is restarted, the checkbox will be checked.
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. .M A N A G E  A S S E T  R E A D S
Asset Read Overview
ASS ET RE A D SE TU P

When the required fields have been completed, you are ready to begin collecting asset data 
with the barcode scanner.

Tips: Taping the ok button in the upper right-hand corner of the screen will save the entries to the 
scanner. If you need to exit the screen without saving, Tap the “X” just below the ok button. 

Figure 3-5: Perform asset reads setup.

. . . . . . . . . . . . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak 

• Tap Setup

• If empty, enter a valid name in the 
Operator Name field

• Select a Structure Level 1 Type 

• Select a Structure Level 2 Type

• Optionally check Scan & Go

• Optionally check RFID Use

• Tap OK to save

FIELD NAME DESCRIPTION/EXPLANATION

Operator Name Enter or select from the list of values if your user name does not auto-populate.

Structure Level 1 Type
Structure Level 1Types defines structures such as buildings, warehouse, or containers. 
Essentially any structure that may contain one or more rooms, compartments, or bins in which 
items may be stored. This is a required field.

Structure Level 2 Type
Structure Level 2 Type defines a substructure such as room or wing within a Structure Level 1 
Type in which assets may be stored. This type provides a lower level of specification in the 
storage location of your asset. This is a required field.

Scan & Go Optional. Only select if you do not wish to view scanned asset details.

RFID Use Optional. Only select if your organization utilizes RFID technology for its assets. Restart is 
required.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . R E C O R D  A S S E T  R E A D S

Once you have defined the Asset Read Setup screen on the scanner, you can begin recording 
asset reads (resolutions). The process of recording asset reads is a simple and easily 
executed process that uses a barcode scanner to collect data on assets that are a part of your 
physical inventory.

Tap the Asset Read icon. Specify your current location. Each resolution you record is captured 
using the current location that you establish on this screen. As you move from location to 
location, return to this screen to update the barcode scanner’s location.

Recording Asset Reads involves the following steps:

Step 1   Select the Asset Read Type: Specify one of the two options available:

•  Asset Read Only

•  Asset Read with Updated Location

Step 2   Define Location: Specify the current location for the scanning activity and Tap the Next 

button.

Step 3   Record the Asset Read: Scan the 1D, 2D, or RFID asset tags (or enter manually).

Step 4   Review the Scan: Apply changes to asset reads as needed by either Tapping the 

Update button or the New button.

The steps above are accessed through the main menu using the Asset Read  icon. 

The following pages will discuss and illustrate how to perform the steps listed above.
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. .M A N A G E  A S S E T  R E A D S
Record Asset Reads
SE L EC T T HE AS SE T RE AD TY P E

To record an asset read using the scanner you are required to define the type of asset read 
you plan to perform. Two options are available:

• Asset Read Only 

• Asset Read with Updated Location

The selected mode is indicated by the drop-down list located at the top of the Asset Read 
screen just below the Sunflower MobileTrak menu bar.

Figure 3-6: Asset Read selections

Tap the Cancel button to return to the MobileTrak main menu.

Note: The Next button will activate after you have entered the appropriate Location 
information. Site level is the minimum required location entry.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Asset Read

• Select an asset 
read type from 
the drop down 
menu
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A S S E T  R E A D  O N L Y

Use the Asset Read Only option to record asset reads without changing location information. 
Selecting this option will allow you to record that you scanned the asset against the current 
asset location definition from the Sunflower Assets database. This option will not update the 
asset’s location in Sunflower Assets since the location has not changed.

Step 1   Tap the Asset Read icon from the MobileTrak main menu.

Step 2   Select Asset Read Only as the asset read type from the drop down list. Selecting this 

option indicates that you are not updating the asset’s location with new location 

information.

A S S E T  R E A D  W I T H  U P D A T E D  L O C A T I O N

Use the Asset Read with Updated Location option to specify new location information for 
assets you plan to scan. Selecting this option will update the asset’s location in Sunflower 
Assets if the scanned location is different from the asset’s location as reflected in your 
Sunflower Assets database.

The login of the person uploading the asset reads through Synclink has to be authorized to 
update assets’ locations. This authorization is performed in the Administration module of 
Sunflower Enterprise as part of the setup for user roles. If the person is not authorized to 
update location data, the Resolution information is still processed in the Review module; 
however, the location will not be updated.

Step 1   Tap the Asset Read icon from the MobileTrak main menu.

Step 2   Select Asset Read with Updated Location as the asset read type from the drop down 

list. Selecting this option indicates you are or are intending on updating an asset’s 

location with new location information.
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Record Asset Reads
DEF I N E LOC AT I O N

After selecting an Asset Read Type, you will need to specify your current location for the 
scanning activity. Each asset read you record is captured at the location you have entered on 
this screen. As you move from location to location you will need to return to update the location 
information on this screen, which is the same screen used to select an Asset Read Type. 

Figure 3-7: Define Location. Specify a current location for the scanning activity

Values available for selection from drop down lists are populated by the reference files 
transferred to the scanner from Sunflower Assets. If you do not see valid values in the drop 
down lists, then it may be necessary for you to do a Send To Scanner in SyncLink.

A Site must be selected from the Site LOV; however, if a Building and/or Room is not available 
in the LOV, you may type in the correct value.

Note: Once you enter the appropriate data and Tap the Next button you must return to this 
screen in order to exit the Asset Read function and return to the main menu.

The steps on the next page describe how to define a location for an asset read.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Asset Read

• Select the 
appropriate 
location data 
from the drop 
down menu
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The Define Location screen consists of the following field parameters and actions: 

Figure 3-8: Define Location fields

Step 1   Select Asset Read with Updated Location or Asset Read Only as the asset read type 

from the drop down list to indicate whether your are updating the asset’s location or 

not when capturing asset resolutions.

Step 2   Use the drop down list to select the Site.

Step 3   Enter the asset’s Building (Structure Level 1).

Step 4   Enter the asset’s Room (Structure Level 2).

Step 5   Optionally, enter the asset’s Structure Level 3 (e.g. Container, bin, etc.).

Note: The Operator name field is display only. To change this value, tap ok or Cancel to go 
back to the Main Menu and then select Setup.

NOTE: If FORCEAUTH = Y, then the operator name is from the SyncLink logon ID 
and can not be modified by the handheld’s operator.

Once you have defined your current location you are ready to begin scanning assets. Tap the 
 button to begin the scanning process.

Parameter Definition Example

Site The asset’s site. San Francisco, Palo 
Alto, Livermore

BUILDING
(Structure 
Level 1)

The main structure of the asset.
Note: The parameter name is dynamic and is based on 
the value selected for Structure Level 1 Type on the Setup 
screen. Automatically clears if a new Site is selected.

100, Administration, 
Wing A, Parking Lot 
15A

ROOM
(Structure 
Level 2)

The substructure of the asset.
Note: The parameter name is dynamic and is based on 
the value selected for Structure Level 2 Type on the Setup 
screen. Automatically clears if a new Building is selected.

123, Property Office

Struct Level 3 Optional. The specific section of the substructure defined 
by Structure Level 2 of the asset is located.

Container, Safe, Bin

Operator Name of the person performing the scanning.
Note: Can only be changed on the Setup screen.

ADM01,ONE,ADM or 
1234,DOE,JOHN
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Record Asset Reads
REC OR D TH E AS SE T REA D

Recording asset reads with a barcode scanner is as simple as “point and shoot.” In addition to 
supporting traditional scanning methods for 1D barcodes, MobileTrak is also equipped to 
support the scanning of 2D data matrices (Mark) and multiple simultaneous reads of RFID 
tags. In the event a barcode is damaged or unscannable, MobileTrak’s manual entry feature 
can be used to key in the asset identifier, DOD UID, or Sunflower UID. 

Step 6   Scan the asset’s 1D barcode, 2D data matrix (Mark), or RFID tag. After each scan, the 

asset will appear on the Asset Read screen.

Note: MobileTrak Release 4.6 is equipped to perform multiple simultaneous reads of RFID 
tags. If this is this case for your organization, all the assets scanned will be listed on the Asset 
Read screen after a single push of the scan button. 

Figure 3-9: Asset read output.

The Asset Reads screen consists of the following field parameters and actions: 

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Asset Read

• Select the 
appropriate 
asset read type 
from the drop 
down menu

• Scan the asset’s 
1D barcode, 2D 
data matrix, or 
RFID tag

• The asset(s) will 
appear in the 
Asset Reads 
box

Parameter Definition Example

Asset Reads 
checkbox

Displays the scanned or manually entered asset barcode(s) 
and is automatically selected (checked).

0201

Existing Indicates if the asset is in the current Sunflower database 
that was transferred to the scanner or not.

Yes or No
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Figure 3-10: Define Location fields

Step 7   Tap  to create all resolutions without updating or adding new assets.

Step 8   If you wish to scan another asset, simply scan the barcode or Tap the Edit icon.

Continue scanning or manually entering the asset barcodes until you have scanned/entered all 
applicable assets within the current location.

Tap  to create one resolution or all of your resolutions.

You can then Tap the Back button to return to the previous screen, enter a new location, Tap 
the Next button and resume scanning.

Edit icon Tap the Edit icon to manually enter the barcode.

Data display Automatically displays existing asset data for the asset, 
which includes Module (i.e. INV for Inventory), catalog 
information, and Serial number.

INV COMPUTER
“Catalog data”
929302

Back button Initially inactive since nothing has been done. When 
enabled, allows you to return to the previous screen.

select as required

Cancel button Initially inactive since there is nothing to cancel. When 
enabled, select to cancel this asset read, which removes 
the asset from the list without processing the resolution.
Note: If selected a confirmation pop-up window displays to 
verify whether you wish to cancel.

select as required

Update button Select to update data for existing assets. Takes you to the 
Update screen, which is a 2-page data entry screen.
Note: Update displays for assets found in the database. If 
you scan/enter an asset not found, this button automatically 
changes from Update to New.

select as required

OK icon Used to process your asset resolutions.
Note: The ok icon Does Not take you back to the main 
menu. To return to the main menu you must Tap the back 
button and then Tap the ok icon.

select as required
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ALT E RN AT E MA NU AL AS S ET ID EN T I F I ER/UID ENT RY ME TH OD

As previously discussed you can Tap the Edit icon to perform a manual entry or you can use 
the alternate method for manual entry, which is holding the Stylus onto the Asset Read screen 
until a Blue Enter identifier/UID box displays, as shown below.

Step 1   Hold down the Stylus for a few seconds in the blank portion of the Asset Reads screen 

until the Enter identifier/UID box appears, as shown below. 

Figure 3-10: Manual asset identifier/UID entry

Step 2   Tap the Enter identifier/UID box, which opens a data entry field to the right of the Edit 

icon and automatically places your cursor in this field.

Note: For manual data entry you can use your scanner’s keypad or Tap the Keyboard icon in 
the lower right-hand corner (circled above) to display an on-screen keyboard that you can use 
for data entry.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Asset Read

• Select the 
appropriate 
asset read type 
from the drop 
down menu

• Hold down the 
stylus in the 
blank box until 
prompted to 
enter the 
identifier/UID

• Enter the 
identifier/UID 
and click Enter 
on the keypad
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Step 3   Use your scanner’s keypad or on-screen keyboard to enter the asset Identifier, DOD 

UID, or Sunflower UID, as shown below.

Step 4   Either click the Enter button on your scanner’s keypad or Tap the Return key that is on 

the scanner’s on-screen keyboard. 

Figure 3-11: Populated Asset Selector screen using manual entry

When the asset has been entered, the Asset Selector section of the screen will be populated 
with the asset information just as if it had been scanned.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Asset Read

• Select the 
appropriate 
asset read type 
from the drop 
down menu

• Hold down the 
stylus in the 
blank box until 
prompted to 
enter the 
identifier/UID

• Enter the 
identifier/UID 
and click Enter 
on the keypad
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UPD AT E ASS E T INF OR MA TI ON

After scanning or manually entering an asset that is found in the reference file, you may 
change a wide variety of information. Perform the following to edit the asset’s information.

Figure 3-12: Update asset details screen

Step 1   Scan or manually enter an asset and then Tap the Update button, which opens the 

Update screen, as shown above on the left-hand graphic.

Step 2   Tap the Next button, which takes you to the Update Asset - Page 2 of 2 screen, as 

shown above on the right-hand graphic.

Step 3   Update the appropriate data.

Note: Use the vertical scroll bar as required to update the appropriate field. 
The PO Number and PO Line Item fields are only enabled when selecting Asset Receiving 
from the main menu. 
The Quantity field is only enabled if the asset is a commodity asset. 
The Find icon must be used to provide a list of values.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Asset Read

• Scan or 
manually enter 
the asset 
identifier/UID

• Tap the Update 
button
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Step 4   Tap the  icon to save your changes and return to the Asset Reads screen or Tap 

the Cancel button to cancel your changes.

Once you have tapped the  icon, MobileTrak displays a message indicating that your 
record data has been saved, as shown below.

Figure 3-13: Populated Asset Selector screen using manual entry

You can either continue scanning other assets or Tap the Back button to return to the Asset 
Reads Location screen.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Asset Read

• Select the 
appropriate 
asset read type 
from the drop 
down menu

• Enter the 
identifier/UID 
and click Enter 
on the keypad

• Tap the Update 
button

• Tap the ok icon
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•

ASS ET NO T FO UN D I N  REF E RE NC E F I L E S

When an asset has been scanned or manually entered and MobileTrak does not recognize it 
as part of the reference database, MobileTrak indicates that it is not an Existing asset, as 
shown below. 

Figure 3-14: Asset not found in reference database

Notice that the Asset Selector fields are not populated, the Existing column indicates the asset 
is not in the reference database, and the Update button has automatically changed into a New 
button.

When an asset is scanned (or manually entered) and it is not in the database, the scanner 
operator has the following four options:

• Create a new asset

• Create a new SKU (used for commodity assets)

• Apply a Mark to an existing asset

• Tap the Cancel button to clear the asset read.
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Record Asset Reads3  
C R E A T E  A  N E W  A S S E T

The Create New Asset feature enables you to create a new asset record through MobileTrak. 
Perform the following steps to create a new asset:

Step 1   Tap the New button on the Asset Read screen to select an action.

Figure 3-15: Select Action. Three options are presented when an asset is not found in the reference 
database

Step 2   If required, Tap the Create New Asset radio button.

Step 3   Tap the  button.

. . . . . . . . . . . . . .
NAVIGATION

• Tap the New 
button from the 
Asset Read 
Screen

• Select Create 
New Asset

• Tap Next
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Record Asset Reads
Step 4   Complete the data entry fields by entering the appropriate data or selecting the entry 
from the drop down list (required fields have an asterisk).

Figure 3-16: Create New Asset screen; use the Next and back buttons as required

Step 4   Tap  to save the entered data and return to the Asset Read screen.

FIELD NAME VALUE DESCRIPTION/EXPLANATION

Interest Type INVENTORY ASSET Required. Select the appropriate module from the drop-down.

Identifier defaults Defaults from your scan or manual entry on the Asset Read screen, but can be 
changed.

Manufacturer DELL Required. Enter the appropriate manufacture and Tap the Find icon.
Model Name D333 Required. Enter or select the appropriate model name from the LOV.
Official Name defaults Defaults, based upon the catalog Manufacturer/Model combination.
Manager Sunflower Systems Optional. If known, enter the Manager and Tap the Find icon.
Steward Asset Center 01 Optional. If known, enter the Steward and Tap the Find icon.
Custodian 050598,DOE,JOHN Optional. If known, enter the Custodian and Tap the Find icon.
User Kristen Frazier Optional. If known, enter the User and Tap the Find icon.
Serial Number 12345 Optional. If known, enter the asset’s serial number.
PO# shaded This field is only available when adding assets using the Asset Receiving screen.
PO Line Item shaded This field is only available when adding assets using the Asset Receiving screen.
Condition USED - GOOD Optional. Enter or select the asset’s condition from the LOV.
Quantity shaded This field is only available when creating asset reads for commodity assets.
UDFs VAULT A As required. User Defined Fields (UDFs) allow capture of additional data.
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C R E A T E  N E W  S K U

Currently you can not create a new commodity asset using Sunflower MobileTrak. This choice 
provides the information that you scanned or manually entered a Stock Number and not an 
Asset Identifier.

This example shows what happens if you attempt to create a new SKU using MobileTrak after 
scanning a new Commodity Barcode or Tag Number.

Step 1   Tap the Next button on the Asset Read screen to select an action.

Figure 3-17: Create New SKU

Step 2   Tap the Create New SKU radio button.

. . . . . . . . . . . . . .
NAVIGATION

• Tap the Next 
button from the 
Asset Read 
Screen

• Select Create 
New SKU

• Tap Next
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Step 3   Tap the  button.

Step 4   View the system generated message, as shown below. 

Figure 3-18: Create New SKU

In this situation you must Tap the ok icon, which returns you to the Asset Reads screen. Tap 
the Cancel button to cancel this scan and report your finding based upon your Business Policy.

. . . . . . . . . . . . . .
NAVIGATION

• Tap the Next 
button from the 
Asset Read 
Screen

• Select Create 
New SKU

• Tap Next
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A P P L Y  M A R K  T O  A N  E X I S T I N G  A S S E T

In addition to scanning traditional barcode technologies, MobileTrak also has the ability to 
recognize a 2D data matrix (Mark) affixed to assets. This choice provides the information that 
an additional or different type of tag has been affixed to the asset. For example, in the event a 
2D data matrix is affixed to an asset that previously used a 1D barcode. Is this a new asset or 
is it an existing asset that has a new barcode technology affixed to it? If the latter is the case, 
MobileTrak can apply the new mark to the existing asset.

Step 1   Scan the 2-D Mark, which displays on the Asset Reads screen.

Step 2   Tap the New button on the Asset Read screen to select an action.

Step 3   Tap the Apply Mark to an Existing Asset radio button, which activates a data entry field. 

Figure 3-19: Apply Mark to an Existing Asset

Step 4   Scan (or manually enter) the 1-D asset identifier or UID.

Step 5   Tap  to save the entered data and return to the Asset Read screen.

• If you determine that the new mark should not be applied to the asset, you can delete the 
transaction using the Review Scans feature.

. . . . . . . . . . . . . .
NAVIGATION

• Tap the New 
button from the 
Asset Read 
Screen

• Select Apply 
Mark to an 
Existing Asset

• Scan or Enter 
the 1-D 
Identifier/UID

• Tap ok
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . R E V I E W  T R A N S A C T I O N  C O U N T S

The Transaction Counts screen is used to review data stored within the barcode scanner 
according to the type of transaction that occurred. This screen displays two columns: 
Transaction Type and Count. Transaction Type lists the types of transactions processed while 
using the barcode scanner (e.g. Asset Addition, Add Mark, Asset Change, etc.). The Count 
column displays the corresponding number of records associated to the transaction type.

Figure 3-20: Transaction Counts screen and fields

Tap  to exit the Transaction Counts screen and return to the main menu.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Transaction 
Counts

Parameter Definition

Transaction Type Displays the types of transactions processed while using the barcode 
scanner.

Count Displays the number of records associated with each transaction file.

Delete All button Tap to erase all files from the scanner.
Note: This action cannot be undone.

Delete by Transaction 
button

Tap to erase all files of a specific transaction type from the scanner (e.g. all 
Asset Additions, all Asset Changes, etc.). 
Note: This action cannot be undone.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . R E V I E W  S C A N S

While the Transaction Counts feature provides a high level overview of the scans made during 
a physical inventory, the Review Scans feature drills down for more detail about the individual 
asset scans. Once assets have been scanned and saved, you may review the various asset 
reads from the Review Scans screen. Use the arrows at the bottom of the screen to review all 
the asset records. 

Figure 3-21: Review Scans screen

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Review 
Scans

• Use the arrow 
buttons to 
review assets

Parameter Definition

Field Displays the field names.

Value Displays the information in the field for the specified asset.

Asset Number Displays the record number of the asset you are viewing and the total number of records entered.

Delete button Marks the individual asset scan for deletion. This function is shown in the next exercise.

Arrows (<<, <, >, >>)
Use these arrows to move back and forth between assets.
<< = Go to the First asset record. < = Go to the Previous asset record
> = Go to the Next asset record >> = Go to the Last asset record

Up & Down arrows Use these arrows (circled) like the Arrow Up and Arrow Down keys on a computer keyboard to 
move back and forth between assets.

Go button Optionally enter an assets record number (i.e. 5) and tap the Go button to display the asset.
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DEL E TE A N ASS E T SC AN

Individual asset reads can be deleted from the scanner before uploading the data back to the 
Sunflower Assets database via SyncLink. Taping the Delete button will mark the individual 
asset scan for deletion, but will not delete the asset until you Tap the ok button.

If you want to undo the deletion before saving, Tap the Undelete button. Once a record is 
deleted from the scanner, it cannot be recovered. You will need to rescan the asset to include 
it in the physical inventory.

Figure 3-22: Asset marked for deletion

Step 1   Use the arrow buttons to locate the asset to be deleted.

Step 2   Tap the Delete button (which changes to Undelete) to mark the asset for deletion.

Step 3   Tap the  button to save the deletion.

• To cancel deletions, Tap the Undelete button or Tap the  icon.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Start icon

• Tap MobileTrak

• Tap Review 
Scans

• Use the arrow 
buttons to 
review assets

• Tap the Delete 
button to mark a 
scan for 
deletion
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . P E R F O R M  A S S E T  R E C E I V I N G

New to MobileTrak 4.6 is the Asset Receiving functionality. The Asset Receiving screen was 
created to help organizations with receiving staff use their barcode scanners configured with 
MobileTrak to easily and quickly receive new assets into inventory.

The Asset Receiving screen works exactly the same way as the Asset Read screen, except 
the PO # and PO Line Item fields are now available for the appropriate purchasing data entry.

No resolutions are recorded when using Asset Receiving.

Note: During installation, user code must be established to handle the two purchasing fields 
data entry when barcode scanned data is sent to the Sunflower Enterprise database. 
Otherwise the PO # and PO Line Item data will be lost during the barcode scanner upload 
process.

Figure 3-23: Asset Receiving

Step 1   If required, tap Setup and enter the appropriate data.

Step 2   Tap Asset Receiving.

Step 3   Select the appropriate Asset Read (i.e. Asset Read Only) and Location (i.e. Site = 

LIVERMORE), as shown above left, and Tap the Next button.

Step 4   Scan or manually enter the asset data, as shown above right (ID = 54321).

Step 5   Tap the New button to go to the Receive New screen.
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Step 6   Enter the appropriate data. If applicable, enter the PO # and PO Line Item fields, which 

are now activated and available for data entry on Page 2 of 2, as shown below.

Step 7   Use the Next and Back buttons as required to complete the data entry. 

Figure 3-24: Asset Receiving Data Entry
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Perform Asset Receiving3  
Step 7   Upon completion of the data enter, Tap ok to return to the Asset Reads screen. 

Figure 3-25: Asset Receiving - Record Saved

Step 4   Tap OK to close Asset Receiving.

. . . . . . . . . . . . . .
NAVIGATION

• Tap Asset 
Receiving

• Enter the 
appropriate Site 
and Tap Next

• Scan or Enter 
the 
Identifier/UID

• Tap New

• Enter the data

• Tap ok
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UPLOAD PHYSICAL INVENTORY 4

Then you have completed the task of scanning assets for 
your physical inventory, you will use SyncLink to transfer 
data from the barcode scanner to your Sunflower Assets 

database. This chapter discusses the steps involved to upload 
physical inventory data from the scanner, verify uploaded data, delete 
scanner files, and manage errors using the SyncLink application and 
the Sunflower Assets application.

This chapter includes the following discussion points and concepts:

• Upload Asset Reads

• Delete Barcode Scanner Files

• Manage Errors with Reports

• Manage Errors with Forms

W
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Upload Asset Reads4  
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . U P L O A D  A S S E T  R E A D S

After you have completed the scanning (and/or manual entry) activities for your physical 
inventory, you will need to upload the collected data to your Sunflower Assets database via 
SyncLink. Recall that SyncLink acts as the conduit to transfer data between your PC and the 
barcode scanner for use with the MobileTrak application. This chapter will discuss how to:

• Transfer (upload) asset reads from the barcode scanner to your Sunflower Assets 
database

• Process asset reads that were transferred (uploaded) to the interface tables in your 
Sunflower Assets database

Note: Only records with errors will be in the interface tables, awaiting resolution.

Depending upon your settings more than one interface table may be involved. For example; if 
an error exists in the resolution of an asset record the Review Interface table will be affected 
(Path: Review > Edit Resolution Interface Records).

However, if an error exists with a location data update for an Inventory Management asset 
record the Management Interface table will also be affected (Path: Mgmt > Edit Inventory 
Asset Interface Records).

UPL OA D ASS E T REA DS T O T HE SU NF LO WE R AS S ET S DA TA BA SE

With just a few clicks of your mouse, SyncLink provides an easy mechanism for transferring 
(uploading) data from the barcode scanner to your Sunflower Assets database and/or 
interface tables. Ensure the scanner is in the cradle and connected to your PC before 
commencing the upload process.

Step 1 Place the scanner into its cradle (verify it connected to your PC).

Step 2 Ensure you have shut down MobileTrak.

Step 3 Start SyncLink and enter your Username and Password on the login page.

Step 4 Highlight MobileTrak in the Application Name column.
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Upload Asset Reads
Step 5 Click the Get From Scanner button.

Step 6 Acknowledge the reminder message to shutdown MobileTrak. 

Figure 4-1: Transfer (upload) barcode scanner files via 
SyncLink to the Sunflower Assets database

. . . . . . . . . . . . . . . . 
NAVIGATION

• Place the scanner in 
the cradle, verify it 
is connected to your 
PC

• Start SyncLink and 
enter Username 
and Password

• Select MobileTrak in 
the Application 
Name column

• Click the Get From 
Scanner button
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Upload Asset Reads4  
Step 5 View the results of your barcode processing, as shown below.

Note: The Messages field is not used for showing why records failed to process. This area is 
used to display errors in getting data to the database (such as the reason that the information 
is not physically getting from the scanner to the database). The Next and Previous buttons, 
when activated, allow you to scroll back and forth between different error messages.

Figure 4-2: SyncLink upload results

Step 5 Click the Ok button. A Delete Files pop-up window displays.

. . . . . . . . . . . . . . . . 
NAVIGATION

• Click Get From 
Scanner
4 -100 Sunflower MobileTrakTM User Guide 4.6 Sunflower Systems © 2008 April



. .
 . 

. .U P L O A D  P H Y S I C A L  I N V E N T O R Y
Delete Scanner Files•
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . D E L E T E  S C A N N E R  F I L E S

When uploading is complete, you will receive a prompt asking if you would like to delete the 
files from the scanner. Deleting the existing files from your barcode scanner will prevent 
uploading the same resolutions, changes, and additions more than once, which would result in 
an error message. SyncLink will display the following message when the upload is complete: 

Figure 4-3: Delete scanner files

S E L E C T I N G  Y E S  O R  N O  T O  D E L E T E  U P L O A D E D  F I L E S

The answer to this question depends on your understanding of the Upload Results form shown 
on the previous page. In this example it shows that all of the resolutions failed to process from 
the load tables into the core Sunflower Enterprise. In addition, the one change or create new 
asset also failed to process.

Print out the Resolution Interface Processing Results report (Reports > Review Reports > 
Resolution Interface Processing Results) and the appropriate Asset Interface Processing 
Results report(s). 
For example, if you changed an Agreement asset and created an Inventory asset then you 
need to print both the Agreement Asset Interface Processing Results and the Inventory Asset 
Interface Processing Results reports.

If you understand the outcome of the report’s results, then click the Yes button and delete the 
files.

If you select the No button you can always go back to the scanner, Tap Transaction Counts, 
and then Tap Delete All.

In addition, in the Upload Results form, if the number of records in the file is greater 
than the number of total resolutions then contact your organization’s authorized 
representative to get help.

Essentially, when you receive any failures in the Upload Results form, you need to run 
the appropriate report and go to the applicable form in Sunflower Enterprise and 
resolve the failures.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . M A N A G E  E R R O R S  W I T H  R E P O R T S

Errors can occur during the processing of the interface table records. Sunflower Enterprise 
provides a report that displays the details of processing the interface records that have been 
uploaded from the barcode scanner. Some of the errors may be due to invalid values entered 
in the MobileTrak fields or insufficient rights for the user to upload the resolutions to Sunflower 
Enterprise.

You can run the Resolution Interface Processing Results report directly from SyncLink by 
selecting Reports from the File menu. Alternatively, you can also run the appropriate reports in 
Sunflower Enterprise by selecting Reports > Management Reports and then selecting the 
Inventory Asset Interface Processing Results report from the menu and then selecting Reports 
> Review Reports > Resolution Interface Processing Results. The benefit from running the 
report from SyncLink is that the Load Group value will auto populate.

Figure 4-4: Resolution Interface Processing Results

. . . . . . . . . . . . . .
NAVIGATION

• Click File

• Click Reports
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Use the following steps to create an Interest Asset Interface Processing Results report.

Step 1 Select Reports from the SyncLink File menu, as shown on the previous page.

Step 2 Select a file display output type; either Adobe Acrobat or HTML, as shown below.

Step 3 Click the eXecute button to create the report.

Figure 4-5: Inventory Asset Interface Processing Results

Note the Load Group, which can be helpful on the Interface forms.

. . . . . . . . . . . . . . . 
NAVIGATION

• Click File

• Click Reports

• Select Acrobat or 
HTML as the file 
output

• Click the eXecute 
button
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Step 5 View the report, an example of which is provided below.

Figure 4-6: Report Output

This report example shows that 3 items were processed Successful and 1 item Failed.

. . . . . . . . . . . . . . . 
NAVIGATION

• Select Adobe or 
HTML as the file 
output

• Click Execute to 
run the report
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RUN T HE BCR UP LO AD D I F F ER E NC ES DE TA I L  BY AS SE T RE PO RT

New to MobileTrak 4.6, are two reports specific to barcode processing, which are available 
from the Barcode menu in Sunflower Enterprise v4.5 application.

• BCR Upload Differences Detail by Asset report

• Updates Made Through Inventory report 

The BCR Upload Differences Detail by Asset report is only populated if there were errors in the 
barcode scanner to Sunflower Enterprise database upload process, either due to missing or 
incorrect data or possibly a lack of privileges on the barcode user. This report can also be run 
from the Differences Detail By Asset form by clicking the Print Report button at the bottom of 
the form. This report provides a line-by-line comparison of the original Sunflower Enterprise 
database information and what was entered through the barcode scanner.

.

Figure 4-7: BCR Upload Differences Detail By Asset Report 
Parameter Page

Step 1 Navigate to the Barcode Reports screen.

Step 2 Select the BCR Upload Differences Detail By Asset link.

. . . . . . . . . . . . . . . . . . . 
NAVIGATION

• Click Reports

• Click Barcode Reports

• Click BCR Upload 
Differences Detail By 
Asset
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Step 3 Enter or select the desired Load Group from the List of Values.

Step 4 Optionally, enter the desired Record Group or leave this field blank.

Step 5 Click the Submit button.

Step 6 Chose an output format, either Acrobat or HTML and click the eXecute button.

Step 7 View the report output. The example shown below is for a new asset.

Figure 4-8: Report Output

Step 5 Either close the report or click the Browser Back button three times.
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RUN T HE UP DA T ES MA DE TH RO UG H IN V EN TO RY RE P ORT

The Updates Made Through Inventory report provides a historical look at changes made to 
assets through the barcode scanner process. You can either run the report for a load group or 
for a number of load groups (uploads) over a given period of time.

.

Figure 4-9: Updates Made Through Inventory Report 
Parameter Page

Step 1 If required, navigate to the Barcode Reports screen.

Step 2 Select the Updates Made Through Inventory link.

Step 3 Either enter a Load Group or a date range.

Note: For a detailed output, select (check) the Details checkbox.

Step 4 Click the Submit button.

Step 5 Chose an output format, either Acrobat or HTML and click the eXecute button.

. . . . . . . . . . . . . . . . . . . 
NAVIGATION

• Click Reports

• Click Barcode Reports

• Click Updates Made 
Through Inventory
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Step 6 View the report output, as shown below.

Figure 4-10: Updates Made Through Inventory Report Output

Step 5 Close the report.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . E R R O R  M A N A G E M E N T  W I T H  F O R M S

New to MobileTrak 4.6, two new forms (screens) are available from the Barcode menu within 
the Sunflower Enterprise application that help you to manage and resolve errors in barcode 
processing.

• Differences Detail by Asset form

• Error Detail By Error Code form

DI FF E RE NC E S DET AI L  BY AS S ET

When you upload the data from your barcode scanner, there may be incorrect data or missing 
required data field information. If this occurs, the appropriate identifier information will stay in 
the load table, where you can view and correct the error(s).

Note: Data will only display on this form if there is an error.

Figure 4-11: Differences Detail by Asset form

. . . . . . . . . . . . . . . .
NAVIGATION

• Click Barcode

• Click Differences 
Detail By Asset
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Step 1 Navigate to the Differences Detail by Asset form.

Step 2 Use the default values or select as desired.

Tips: After resolving the error (or errors), click the Save icon to save your changes and allow the 
system to validate the revised data. If there are no further errors, then your data entry will 
automatically update the Sunflower Assets database and no longer display on the Differences 
Detail by Asset form.

FIELD NAME DESCRIPTION/EXPLANATION

Load Group
Enter the specific load group designation or click the Find icon twice to populate the form. For 
training, click the Find icon twice.
Note: If the Vertical scrollbar is activated (as shown on the previous page), you can use the 
Arrow Down and Up keys on your keyboard to view other Load Group data.

Record Group Displays the system assigned record group number.

Use Indicators 
checkbox

Used to determine how you want the system to process “Null” or blank data fields. 
If the Default = False (unselected), all fields that have an upload value of NULL will be affected. 

Identifier Displays the asset Identifier.
Recorded By Displays who performed the barcode scan.
“Message Window” Displays the error or problem that needs to be resolved.

Update Inventory Asset block

Show All? checkbox
Default. Shows all Barcode related fields.
Note: Uncheck to display only those lines that have the Modified? checkbox selected, which are 
those that have been changed or modified.

“Display Field” The Field/Context displayed coincides with the line item selected (highlighted). Used to update 
New (As Recorded) Value data as appropriate.

Change button Use this button to populate (change) the selected New (As Recorded) Value data based upon 
your entry in the “Display Field.”

Modified? checkbox Autopopulates to show those line items that have changes between the Old (current SFA 
database) and New (barcode) data.

Field/Context Displays the MobileTrak Barcode fields.

Old (Current) Value Displays the Sunflower Asset’s database source (reference) data that was downloaded to the 
barcode scanner.

New (As Recorded) 
Value

Displays the barcode scan or barcode manual entry that was uploaded from the barcode 
scanner.

Print Report button Provides a shortcut to the BCR Upload Differences Detail By Asset report and automatically fills 
in the appropriate search criteria.

Edit Interface Record 
button

Provides a shortcut to the Edit Inventory Asset Interface Records form.
Note: If you click this button, to return to the Differences Detail by Asset form click the Exit icon.
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. .
 . 

. .U P L O A D  P H Y S I C A L  I N V E N T O R Y
Error Management with Forms
ER RO R DET AI L  BY ER ROR CO DE

The BCR Upload Error Detail by Error Code form is used to update one, some, or all records 
for a specific category (i.e. location, catalog, etc.) error.

Note: Data will only display on this form if there is an error.

Figure 4-12: Error Detail by Error Code Form

Step 1 Navigate to the BCR Upload Error Detail by Error Code form.

Step 2 Use default or select values as needed.

Step 3 After resolving the error(s) select the appropriate line items and then click the Save icon 

to save your changes and allow the system to validate the revised data. If there are 

no further errors, then your data entry will automatically update the Sunflower Assets 

database and no longer display on the BCR Upload Error Detail by Error Code form.

. . . . . . . . . . . . . . . 
NAVIGATION

• Click Barcode

• Click Error Detail 
by Error Code
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U P L O A D  P H Y S I C A L  I N V E N T O R Y
Error Management with Forms4  
FIELD NAME DESCRIPTION/EXPLANATION

Load Group
Enter the specific load group designation or click the Find icon twice to populate the form. 
For training, click the Find icon twice.
Note: If the Vertical scrollbar is activated (as shown above), you can use the Arrow Down 
and Up keys on your keyboard to view other Load Group data.

Use Indicators checkbox Used to determine how you want the system to process “Null” or blank data fields. If the 
Default= False (unselected), all fields that have an upload value of NULL will be affected. 

Error Code/Context Displays the system generated error code and context.
#Rows Displays the system generated row information.

“Category Resolution” 
block

Displays the appropriate fields that you can use to fix the error.
In the example shown above, the error deals with an invalid location entry. Therefore, the 
Location* complex field displays. Double-click to open the complex field, enter the correct 
location data, and click the Save icon to close the Locations pop-up window and save your 
location data entry.

Select All button
Select this button to check (enable) all displayed Delta line items.
Note: Only the line items that have the Delta (change) checkbox selected will be affected 
when you save the form.

Unselect All button Select this button to uncheck (disable) all displayed Delta line items.

Ok checkbox Autopopulates upon saving, but only for those line items that have the Delta (change) 
checkbox selected (enabled).

Delta (change) checkbox Determines which line items are affected upon saving. Only those items that are checked 
(enabled) will be affected.

Identifier Autopopulates only for those items where there is an error present.
Additional Fields Additional fields display based upon the nature of the error.
Results If applicable, displays additional error related information.

Edit Interface Record 
button

Provides a shortcut to the Edit Inventory Asset Interface Records form.
Note: If you click this button, to return to the Differences Detail by Asset form click the Exit 
icon.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
GET HELP 5

he Get Help chapter introduces you to the Sunflower Assets 
online context sensitive help system, other methods for 
getting support, and tips for using your Sunflower application.

KEY CO NC EP T S

This chapter will include the following discussion points and concepts:

• Online Help

• Customer Care

• Sunflower Academy

OBJ E CT I V E S

By the end of this chapter, you should be able to:

• Use Context Sensitive Help

• View and Navigate Sunflower Online Help

• Access Sunflower’s Customer Care Website

• Access Sunflower Academy

T
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G E T  H E L P
Use Context Sensitive Help5
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . U S E  C O N T E X T  S E N S I T I V E  H E L P

Use the online Help system to learn more about a form’s function or purpose. The online Help 
System is context-sensitive. Therefore, when activated it will open and automatically take you 
directly to the HTML page that corresponds to your current form (screen). A brief description of 
your current form is provided along with a list of common tasks that you can accomplish with 
the relevant form. Select a Help option (hyperlink) to receive step-by-step instructions about 
how to perform a task. This chapter will acquaint you with Sunflower’s online help system, 
which is always available to assist you.

ACC ES S CON TE X T SE N SI T I V E  ON L I NE HE L P

To access Sunflower’s Online Help, open a form and either click the Tool Bar Help icon (?) or 
select Help > Help from the Menu Bar.

Note: If you are on the Sunflower Splash page (no form open) the Tool Bar (icons) are not 
available. Select Help > Help from the Menu Bar, which opens the Help Main Menu page.

Step 1 Navigate to the Maintain Inventory Assets form.

Step 2 Either click the Help icon (circled) or select Help > Help (highlighted).

. . . . . . . . . . . . . .
NAVIGATION

• Click Mgmt

• Click Maintain 
Inventory Assets

• Click the Help icon 
(?)

or

• Select Help > Help
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. .G E T  H E L P
Use Context Sensitive Help
VI E W CON TE XT SE NS I T I V E ON LI NE HE LP

Once you open the Sunflower Online Help file, you can select the applicable task to review.

Step 1 Review the brief description.

Step 2 Click the Set Flags for an Inventory Asset hyperlink (circled). 

NOTE: The Set Flags for an Inventory Asset detailed help screen is shown on the next page.

. . . . . . . . . . . . . . . . . .
NAVIGATION

• Click Mgmt

• Click Maintain Inventory 
Assets

• Click the Help icon (?)

or

• Select Help > Help

• Click Set Flags for an 
Inventory Asset
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G E T  H E L P
Use Context Sensitive Help5
Step 3 View the Set Flags for an Inventory Asset page, as shown below.  

Step 4 Click the Return to Screen Help button.

Step 5 Click the Return to Module Help button, which displays all help items within the 

Management module.

Step 6 Click the Return to Main Help button, which displays the Main Help menu screen, which 

will be used in the following exercise.

. . . . . . . . . . . . . . . . 
NAVIGATION

• Click Mgmt

• Click Maintain Inventory 
Assets

• Click the Help icon (?)

or

• Select Help > Help

• Click Set Flags for an 
Inventory Asset
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. .
 . 

. .G E T  H E L P
View Sunflower Help (Main Menu)

•

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . V I E W  S U N F L O W E R  H E L P  ( M A I N  M E N U )

The Sunflower Assets Help “Main Menu” provides you with several options for getting 
assistance. You can view any of these help topics at your convenience.

Step 1 If required, close any open Sunflower forms and select Help > Help from the Menu Bar. 

FIELD NAME VALUE DESCRIPTION/EXPLANATION

Sunflower 
Assets Help 
(Main Menu)

Module

 
Help Index 
 
 

Toolbar Help

Frequent Tasks

Search

Click any of the module buttons (i.e. Agree, Mgmt, Finance, Admin, etc.) across 
the top of the page or the hyperlinks listed down the page to view help topics 
associated with those individual modules.

If you know the activity you wish to perform, but don’t know where to locate it 
within the Sunflower Help System you can search for it by expanding the entire 
Help library.

Displays the Tool Bar icons and their uses.

Displays hyperlinks to the most frequent tasks performed with Sunflower Assets.

Enter a word or phrase in the Search for field, select your Find criteria, and click 
Search.
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G E T  H E L P
Search for Help Topics5
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . S E A R C H  F O R  H E L P  T O P I C S

Use the search function provided within the online help system when you know the activity you 
wish to perform, but do not know where to find the help topic discussion in the help system.

Step 1 Click the Search button (circled).

Step 2 Enter the task or key word of the task you wish to perform, such as steward.

Step 3 In the Find field, select any terms.

Note: Using the Sunflower Enterprise Personalized Application View (Term Set) feature 
effects Forms, Report Parameter pages, and Reports. However, Help is constructed of static 
HTML pages and therefore is not currently effected by any Term Set changes or modifications.
5-118 Sunflower MobileTrakTM User Guide 4.6 Sunflower Systems © 2008 April 



. .
 . 

. .G E T  H E L P
Search for Help Topics
Step 4 Click the Search button. 

NOTE: Example Search Results are displayed on the next page.
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G E T  H E L P
Search for Help Topics5
SE AR CH RE SU L TS

Step 5 View the results of your search.

Step 6 You can select any of the hyperlinks to view information related to your search criteria.
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. .G E T  H E L P
Access the Customer Care Website
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A C C E S S  T H E  C U S T O M E R  C A R E  W E B S I T E

Another means of accessing support is through the Sunflower Systems Customer Care 
website.

The Customer Care website provides:

• Sunflower User’s Group information.

• Search (to search the Sunflower Website for desired information).

• Documentation (to access release notes, user guides, installation guides, samples, 
alerts, plus a glossary and FAQs).

• Downloads (to access product downloads and patches).

• Resource Links (to access documents, organizations, regulations, security, publications, 
and other property management related information).

• My Profile (to update your information in order to receive alert and product information).
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G E T  H E L P
Access the Customer Care Website5
NOTE: The Sunflower Systems Customer Care website is accessed via 
sunflowersystems.com. 

Figure 5-1: Sunflower Systems Home Web Site
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. .G E T  H E L P
Access the Customer Care Website
ONL I N E CUS T OME R CAR E SUP PO RT

Sunflower Systems online support gives you the tools to research and answer many of your 
questions through the Sunflower Systems Knowledge Base. Access the Customer Care 
Website by perform the following:

Step 1 Access the Sunflower Systems home page at the following web address with your 

browser, http://www.sunflowersystems.com/.

Step 2 Click the Customer Care link to access the Customer Care website login, 

http://www.sunflowersystems.com/j2ee/ccare/login/index.jsp.

Step 3 Enter your E-mail address and Password; and then click the Enter button.

NOTE: Only existing customers and Sunflower Systems employees may access the Customer 
Care Website. Enter your user name (email address) and password address and click the 
Enter button. 
If you are unable to access the Customer Care Website, please contact your organization’s 
Sunflower Enterprise System Administrator or Sunflower Systems Help at 
helpdesk@sunflowersystems.com.

Figure 5-2: Sunflower Systems Customer Care Login Screen

If you are having any problems accessing the site, call Sunflower Systems Customer Support 
toll-free at 1-866-209-3516 or reach us by email at helpdesk@sunflowersystems.com.

Our Customer Care specialists are liaisons between users, product development, professional 
services, sales and marketing. Sunflower Systems depends on this communication flow to 
fully understand your needs and to ensure successful future product releases.
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G E T  H E L P
Access the Customer Care Website5
SU NF L OWE R SY S TE MS US ER S GR OU P

The Sunflower Systems Users Group provides you with an opportunity to discuss common 
issues and resolutions that arise from the use of the Sunflower applications. Sunflower 
Systems supports the Users Group through participation in monthly teleconferences, quarterly 
web-based education-related updates, product updates, and subject matter expertise 
discussions.

We encourage all users of Sunflower Systems to join the Sunflower Systems Users Group in 
order to keep up-to-date and informed on the latest events. To participate in the Sunflower 
Systems User Group send your inquiries and feedback to darbee3@llnl.gov.

Figure 5-3: Sunflower Systems Customer Care & Users Group
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. .G E T  H E L P
Access the Customer Care Website
SU NF L OWE R SY S TE MS DO CU ME NT AT I O N

To access documents, select the Documentation (circled) topic on the Customer Care page 
and then click the link of the document that you want to view or download. Click the ‘more’ link 
for an expanded section view. 

Figure 5-4: Sunflower Systems Customer Care Website 
Documentation Page
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G E T  H E L P
Access the Customer Care Website5
Click the desired User Guides link to and an Adobe Acrobat PDF version of the document will 
display for viewing, downloading, and/or printing.

After selecting the desired document, it will automatically open in Adobe Acrobat, as shown 
below.

Figure 5-5: Adobe Acrobat PDF Document Download

You may then copy it to your computer (Save As) and/or print it out.
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. .G E T  H E L P
Access the Customer Care Website
IN S TA LL A TI ON GU I D ES

You can also access Sunflower Systems installation guides to assist you with your 
implementation at the Customer Care website, under the Documentation link.

For example, to access the Sunflower Enterprise 4.5 Installation Guide from the Customer 
Care Website, perform the following:

Step 1 From the Customer Care Documentation page, click the Installation Guides hyperlink.

Step 2 Select the Sunflower Enterprise 4.5 Installation Guide link (Arrow).

Figure 5-6: Sunflower Systems Customer Care Website Installation 
Guides
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G E T  H E L P
Access the Customer Care Website5
Step 3 View and/or save the Installation Guide onto your computer.

Figure 5-7: Sunflower Systems Customer Care Website 4.5 Installation 
Guide
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. .G E T  H E L P
Access the Customer Care Website
ALE RT S

Another resource on the Customer Care Website is the Documentation Alerts page. Click on 
the Alerts link (circled) to view discussions and scripts that impact Sunflower Enterprise’ users. 
Alerts contains information about product application work-arounds and scripts for optimizing 
Sunflower Enterprise.

Figure 5-8: Documentation Alert Page

You can subscribe to the automated Alert system by clicking on the subscription link (arrow).
Sunflower Systems © 2008 April Sunflower MobileTrakTM User Guide 4.6 5-129



G E T  H E L P
Access the Customer Care Website5
Select the alert categories of interest, as shown below.

Figure 5-9: Documentation Alert Subscription Page

After selecting the desired alerts, click the Save button.

Note: You can always return to this screen and change your selections.
5-130 Sunflower MobileTrakTM User Guide 4.6 Sunflower Systems © 2008 April 



. .
 . 

. .G E T  H E L P
Access the Customer Care Website
PR OD UC T DOWN LO AD S

You can use the Product Download resource on the Sunflower Systems Customer Care 
website to view and download the latest available product software and software patches.

Click the Downloads link (circled) to access the Sunflower Systems Product Downloads page 
where you can then select a desired hyperlink to begin the download process. 

Figure 5-10: Sunflower Systems Customer Care Downloads Page
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G E T  H E L P
Access the Customer Care Website5
RES OU RC E L I N KS

In addition to the resources available from the Sunflower Systems Customer Care Website, 
you can use the Resource Links page to find numerous internal and external documents of 
interest covering organizations, government, regulations, security, publications and other 
resources that affect or relate to the Property Management or Sunflower product offering. 

Figure 5-11: Resource Links Page
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. .G E T  H E L P
Access the Customer Care Website
MY PRO F I L E

To keep in touch with the latest information and product application alerts, keep your contact 
information up-to-date with the My Profile page.

Figure 5-12: My Profile Page
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G E T  H E L P
Access Sunflower Academy5
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A C C E S S  S U N F L O W E R  A C A D E M Y

Sunflower Academy™ courses are designed to maximize your valuable time and resources. 
Developed by education specialists with special expertise in adult learning concepts, focused 
sessions get to the details quickly with hands-on workshops and exercises.

From the Sunflower System Home Page select Services > Education to get an overview of the 
training programs offered at Sunflower Systems or email training@sunflowersystems.com.

Figure 5-13: Education Services Page
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. .G E T  H E L P
Site Survey and Upgrade Support Services
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . S I T E  S U R V E Y  A N D  U P G R A D E  S U P P O R T  S E R V I C E S

Sunflower Systems offers comprehensive implementation services to assist enterprises when 
they make the move to a lifecycle asset management system. Critical factors for success 
include understanding the current business processes and defining objectives for the new 
system to ensure that the new lifecycle asset management system meets all of your 
enterprise’s needs including management, finance, IT and your end-users.

More details can be found by clicking the Services link on the Sunflower System Home page 
and then click the Systems Review link to receive a comprehensive review that scopes and 
details the level of effort required to implement a lifecycle asset management system for your 
organization.

Figure 5-14: Implementation Services Page
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Site Survey and Upgrade Support Services5
5-136 Sunflower MobileTrakTM User Guide 4.6 Sunflower Systems © 2008 April 



. . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
FREQUENTLY ASKED QUESTIONS A

Use the following list of frequently asked questions (FAQ) to 
help you troubleshoot while using the MobileTrak 4.6 
application. 

• “Why are the locations of scanned assets not updated?”

• “Why do I not see the changes in Sunflower Assets?”

U
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F R E Q U E N T L Y  A S K E D  Q U E S T I O N SA  
WH Y AR E T HE LO CA TI ON S OF SC AN NE D AS S ET S N OT UP DA TE D?

The location for assets that are scanned will change only under the following circumstances:

• The scanner was set to “Resolutions with Updated Location” on the resolution 
screen

• The person who uploads the data has sufficient privilege to update the asset’s 
location

If the location is not updated due to an invalid location code, the user will be able to resolve the 
error through the Sunflower Assets Edit Interface Resolutions screen.

WH Y DO I  NO T S EE TH E CH AN GE S I N SU NF LO WE R AS S ET S?

When an asset’s information is changed in the barcode scanner, the change will not be 
recorded in the database if any of the following are true:

• The barcode scanner operator does not have sufficient privilege to change the 
asset’s information

• The barcode scanner operator does not possess a role which enables the 
change to be captured or some other unexpected error occurs.

Changes that are not successfully captured can be reviewed via the Edit Inventory Assets 
Interface Records Screen on the Management, Agreements, Finance, Inactive, Excess, or 
Review menus of the Sunflower Assets application. Each change and addition can be 
corrected if necessary and then re-processed by a user with the appropriate privileges.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
COMMON SYNCLINK ERROR MESSAGES B

he following list identifies and addresses common error 
messages that are related to the SyncLink application. Use 
this list to help you troubleshoot while using SyncLink. 

• “The remote server has been paused or is in the process of being started”

• “SyncLink is already running”

• “Unable to parse Sequence ID – A string literal was expected, but no opening quote 
character was found”

• “Error in Form_Load : Error number = ActiveX component can’t create object (429)”

• “Create File Error 5 occurred copying <filename> Access is denied”

• “The system cannot find the file specified”

T
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C O M M O N  S Y N C L I N K  E R R O R  M E S S A G E SB  
THE RE MOT E S E RV ER HA S BE E N PA US E D OR I S  I N  T HE PR OC ES S O F B EI NG S TA RT E D

Explanation: SyncLink was unable to communicate with the bar code scanner. This is usually 
caused by trying to send files to the scanner while MobileTrak is running.

Solution: Close MobileTrak and try again.

SY NCLI N K I S  A LR EA DY RU NN I NG

Explanation: Another instance of SyncLink is already running on your PC. You can only run a 
single instance of SyncLink at any given time. 

Solution: Check if you have SyncLink open on your desktop. If you don’t have SyncLink open 
and are still getting this message, check in the Windows Task Manager to determine if there is 
a SyncLink process, terminate it and retry.

UNA BL E T O PA RS E SEQ UE NC E ID –  A  ST R I NG L I T E RA L WA S EX P EC T ED,  BU T N O OP E NI N G QU OT E 
CH AR AC TE R WA S F OU ND

Explanation: When uploading data, SyncLink requests a sequence ID from your server 
through an HTTP (Web) connection. You will see this error if SyncLink cannot establish a 
connection to the web server or the response from the server is malformed.

Solution: Open your SyncLink.xml configuration file in a text editor and check whether the 
upload_download_url parameter is correct by pointing your browser at the UR formed by the 
value of the upload_download_url parameter + “as_owa_barcode.main”.

ER RO R I N  FO RM_LOA D :  ERR OR NU MBE R =  ACT I V EX COM PO NE NT CA N’T  C RE AT E O BJ E CT (429)

Explanation: One or more of the ActiveX components required by SyncLink is not installed or 
is corrupted. 

Solution: Re-install and setup SyncLink as described in Chapter 2 of the installation guide.
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. .C O M M O N  S Y N C L I N K  E R R O R  M E S S A G E S
CRE AT E F I L E  ERR OR 5  O CC UR RE D C OP YI NG < F I LE NA ME> AC CE S S I S  DE NI E D

Explanation: SyncLink was unable to overwrite the file <filename> in the bar code scanner 
because the file is currently in use. 

Solution: Make sure that MobileTrak is not running and try again.

THE SY ST E M CA NN OT F I N D T HE F I L E  S P EC I F I E D

Explanation: SyncLink was unable to overwrite Scanref.odb in the bar code scanner. because 
the file is currently in use. 

Solution: Make sure that MobileTrak is not running and try again.
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
REPORTS C

his appendix provides a list of the delivered reports that are 
available in the Sunflower Enterprise modules covered within 
this guide. A brief description of each report is provided. The 

following reports are alphabetically listed, either by module or 
function:

• Management Reports

• Review (Physical Inventory) Reports

• Barcode Reports

T
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R E P O R TSC
MA NA GE ME NT RE P OR TS

REPORT DESCRIPTION/EXPLANATION

ASMN6010 Inventory Assets Pending 
Release by Age

Shows a summary of accountable assets pending release to the initial 
custodian by age and steward.

ASMN6020 Inventory Assets Pending 
Acceptance by Age

Shows a summary of assets awaiting acceptance by age and steward.

ASMN6030 Inventory Assets (Global 
Information)

Shows detail and summary information of accountable assets.

ASMN6040 Inventory Assets with 
Requests

Shows accountable assets with open change steward, custodian, user and 
location requests.

ASMN6050 Inventory Assets with 
Recently Denied Requests

Shows accountable assets with denied change steward, custodian, user and 
location requests.

ASMN6060 Inventory Asset History Shows the detailed changes, and who made them, for accountable assets.

ASMN6070 Inventory Asset Final Events Shows the details of accountable asset final events, e.g. loss, abandonment 
and transfer out.

ASMN6075 Inventory Asset Initial Events Shows the details of accountable asset initial events, e.g. purchase, 
construction and transfer in.

ASMN6076 Inventory Asset Ongoing 
Events

Shows detailed information for ongoing events, e.g. maintenance, repairs and 
mileage captured, for accountable assets for a time period.

ASMN6090 Inventory Asset Interface 
Processing Results

Shows the results of processing the contents of interface table 
as_load_inventory_assets.

ASMN6095 High Volume Shipping 
Interface Processing Results

Shows the Bar Code interface processing results.

ASMN6120 Asset Search Searches the asset repository for assets matching a description, manufacturer 
or model; used for asset review.

ASMN6130 Inventory Asset Summary by 
Asset Flag

Summarizes accountable asset value and count by asset flag.

ASMN6140 Inventory Asset Activity 
Summary by Asset Flag

Shows the details of accountable asset activity grouped by asset flag.

ASMN6150 Inventory Asset Utilization Shows the percentage utilization for inventory assets in a time period.

ASMN6160 Inventory Asset Summary by 
Asset Type

Summarizes accountable asset value and count by asset type.

ASMN6170 Inventory Asset Activity 
Summary by Asset Type

Shows the details of accountable asset activity by asset type.

ASMN6180 Asset Structure Shows parent/child relationships between assets.

ASMN6190 Inventory Asset Timeline Shows timeline activities by asset Identifier.

ASPO6010 Purchase Order Aging 
Report

Shows detailed information of outstanding purchases orders requiring receipt 
and tagging of property.
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BAR COD E RE PO RT S

REPORT DESCRIPTION/EXPLANATION

ASRV6010 Review Campaign Base 
Assets

Shows the details of review campaign base assets, by review type, e.g. open, 
barcode scan and barcode key, for a selected set of review campaigns.

ASRV6020 Review Campaign 
Properties

Shows the properties, i.e. baseline criteria, allowed resolution and salient dates, for a 
selected review campaign.

ASRV6030 Review Resolution 
Summary

Shows a summary of physical inventory results, by review type and person for a 
selected set of review campaigns.

ASRV6040 Review Campaign Base 
Assets with Resolution Information

Shows assets subject to an ongoing review with detailed resolution information; also 
provides for hand-written capture of changes to asset steward, custodian, user or 
location.

ASRV6050 Executive Review 
Resolution Summary

Shows percentage found, open and declared unaccounted, for a selected set of 
review campaigns.

ASRV6060 Review Resolution 
Summary by Person

Shows a summary, by resolution type and person, of resolutions captured for a 
selected set of review campaigns.

ASRV6070 Current Resolutions at 
Different Location than Asset

Shows assets whose last physical inventory review occurred at a different location 
than the location of the asset record.

ASRV6080 Review Accruals Shows untagged assets found, and lost assets recovered, for a selected set of review 
campaigns.

ASRV6090 Resolution Interface 
Processing Results

Shows the results of processing the contents of interface table 
as_load_resolution_assets.

ASRV6100 Base Asset Interface 
Processing Results

Shows the results of processing the contents of interface table as_load_base_assets, 
a mechanism which is used to load review baselines from files.

REPORT DESCRIPTION/EXPLANATION

ASMN6200 BCR Upload 
Differences Detail By Asset

Shows the barcode data by asset that contains errors from your scanner upload. 
Displays the data for all barcode related fields in a side-by-side column format, which 
allows you to compare the Old (current Sunflower database) values with the New 
(barcode recorded) values.

ASMN6210 Updates Made Through 
Inventory

Shows a history of changes made to assets through the barcode scanner process. 
You can either run the report for an individual asset or for a number of uploads over a 
giver period of time.
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www.sunflowersystems.com

Need Sunflower Systems Training?

For updates and refresher courses visit us at

https://sunflowersystems.webex.com

Training Questions?

Contact Sunflower Education Services at

training@sunflowersystems.com

http://www.sunflowersystems.com
https://sunflowersystems.webex.com
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